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DISCLAIMER 

This report was prepared as an account of work sponsored by an agency of the United States 

Government. Neither the United States Government nor any agency thereof, nor any of their 

employees, makes any warranty, express or implied, or assumes any legal liability or 

responsibility for the accuracy, completeness, or usefulness of any information, apparatus, 

product, or process disclosed, or represents that its use would not infringe privately owned rights. 

Reference herein to any specific commercial product, process, or service by trade name, 

trademark, manufacturer, or otherwise does not necessarily constitute or imply its endorsement, 

recommendation, or favoring by the United States Government or any agency thereof. The views 

and opinions of authors expressed herein do not necessarily state or reflect those of the United 

States Government or any agency thereof. 

 

The Geological Survey of Alabama (GSA) makes every effort to collect, provide, and 

maintain accurate and complete information. However, data acquisition and research are ongoing 

activities of GSA, and interpretations may be revised as new data are acquired. Therefore, all 

information made available to the public by GSA should be viewed in that context. Neither the 

GSA nor any employee thereof makes any warranty, expressed or implied, or assumes any legal 

responsibility for the accuracy, completeness, or usefulness of any information, apparatus, 

product, or process disclosed in this report. Conclusions drawn or actions taken on the basis of 

these data and information are the sole responsibility of the user. 
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ABSTRACT 

A software package called DFNModeler has been developed to assess the potential risks 

associated with carbon sequestration in coal. Natural fractures provide the principal conduits for 

fluid flow in coal-bearing strata, and these fractures present the most tangible risks for the 

leakage of injected carbon dioxide. The objectives of this study were to develop discrete fracture 

network (DFN) modeling tools for risk assessment and to use these tools to assess risks in the 

Black Warrior Basin of Alabama, where coal-bearing strata have high potential for carbon 

sequestration and enhanced coalbed methane recovery. 

DFNModeler provides a user-friendly interface for the construction, visualization, and 

analysis of DFN models. DFNModeler employs an OpenGL graphics engine that enables real-

time manipulation of DFN models. Analytical capabilities in DFNModeler include display of 

structural and hydrologic parameters, compartmentalization analysis, and fluid pathways 

analysis. DFN models can be exported to third-party software packages for flow modeling. 

DFN models were constructed to simulate fracturing in coal-bearing strata of the upper 

Pottsville Formation in the Black Warrior Basin. Outcrops and wireline cores were used to 

characterize fracture systems, which include joint systems, cleat systems, and fault-related shear 

fractures. DFN models were constructed to simulate jointing, cleating, faulting, and hydraulic 

fracturing. Analysis of DFN models indicates that strata-bound jointing compartmentalizes the 

Pottsville hydrologic system and helps protect shallow aquifers from injection operations at 

reservoir depth. Analysis of fault zones, however, suggests that faulting can facilitate cross-

formational flow. For this reason, faults should be avoided when siting injection wells. 

DFN-based flow models constructed in TOUGH2 indicate that fracture aperture and 

connectivity are critical variables affecting the leakage of injected CO2 from coal. Highly 
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transmissive joints near an injection well have potential to divert a large percentage of an 

injected CO2 stream away from a target coal seam. However, the strata-bound nature of 

Pottsville fracture systems is a natural factor that mitigates the risk of long-range leakage and 

surface seepage. Flow models indicate that cross-formational flow in strata-bound joint networks 

is low and is dissipated by about an order of magnitude at each successive bedding contact. 

These models help confirm that strata-bound joint networks are self-compartmentalizing and that 

the thick successions of interbedded shale and sandstone separating the Pottsville coal zones are 

confining units that protect shallow aquifers from injection operations at reservoir depth. 

DFN models are powerful tools for the simulation and analysis of fracture networks and can 

play an important role in the assessment of risks associated with carbon sequestration and 

enhanced coalbed methane recovery. Importantly, the stochastic nature DFN models dictates that 

they cannot be used to precisely reproduce reservoir conditions in a specific field area. Rather, 

these models are most useful for simulating the fundamental geometric and statistical properties 

of fracture networks. Because the specifics of fracture architecture in a given  area can be 

uncertain, multiple realizations of DFN models and DFN-based flow models can help define 

variability that may be encountered during field operations. Using this type of approach, 

modelers can inform the risk assessment process by characterizing the types and variability of 

fracture architecture that may exist in geologic carbon sinks containing natural fractures. 
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EXECUTIVE SUMMARY 

Coal is potentially an important sink for the sequestration of carbon dioxide, and a software 

package called DFNModeler has been developed to assess the potential risks associated with 

carbon sequestration in coal. Natural fractures provide the principal conduits for fluid flow in 

coal-bearing strata, and these fractures present the most tangible risks for the leakage of injected 

carbon dioxide. DFN models are stochastic realizations based on the statistical properties of 

fracture networks. These models have been used successfully to assess leakage risks associated 

with hydraulic fracturing and coalbed methane production, and these models show promise for 

assessing risks associated with carbon sequestration in coal. The objectives of this study were to 

develop DFN modeling tools for risk assessment and to use these tools to assess risks in the 

Black Warrior Basin of Alabama, where coal-bearing strata of the Pennsylvanian-age Pottsville 

Formation have high potential for carbon sequestration and enhanced coalbed methane recovery. 

DFNModeler software runs under Microsoft Windows operating systems and provides an 

interactive, user-friendly environment for the construction, visualization, and analysis of DFN 

models. The software is driven by a system of menus and dialog boxes that facilitates the input 

and editing of the parameters required to construct DFN models and enables users to customize 

the appearance of those models. DFNModeler employs an OpenGL graphics engine that enables 

real-time translation, zooming, and rotation of DFN models in three dimensions and further gives 

users control over scale, color, and transparency. Analytical capabilities in DFNModeler include 

color contouring of fracture polygons according to structural and hydrologic parameters, 

compartmentalization analysis, and fluid pathways analysis. DFN models can be exported as text 

files to third-party software packages, such as TOUGH2, for flow modeling. 
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DFN models were constructed to simulate fracturing in coal-bearing strata of the upper 

Pottsville Formation in the Black Warrior Basin. Geophysical well logs from the Jobson 24-14 

#11 well, which is being used for the SECARB Black Warrior field test for carbon sequestration 

and enhanced coalbed methane recovery in Deerlick Creek Field, were used as the primary 

stratigraphic control for the models. Outcrops and wireline cores were used to determine the 

basic statistical scaling rules for fracture systems in the upper Pottsville, which include 

orthogonal joint systems, cleat systems, and fault-related shear fractures. Critical variables 

analyzed include the orientation, length, height, spacing, kinematic aperture, and cross-cutting 

relationships for each type of fracture. Results of fracture analysis indicate that the Pottsville 

Formation is dominated by strata-bound fracture networks. Fracture aperture tends to follow 

power-law distributions dominated by hairline fractures with kinematic aperture smaller than 

0.05 mm. Highly transmissive fractures with aperture on the order of 1 mm, by contrast, form a 

small percentage of the fracture population. 

A large DFN model simulating jointing in 96 beds of shale, sandstone, and coal was 

constructed. DFN models were also constructed to simulate cleating, faulting, and hydraulic 

fracturing. Analysis of transmissivity in cleats systems indicates that a strong permeability 

anisotropy is developed in shallow, permeable coal seams and that a loss of transmissivity 

contrast in deep, low-permeability seams makes anisotropy negligible. Compartmentalization 

analysis indicates that strata-bound fracturing compartmentalizes the Pottsville hydrologic 

system. First-order reservoir compartments envelop the major coal zones, and these 

compartments are separated by thick successions of interbedded shale and sandstone that help 

protect shallow coal seams that may be useful aquifers from operations at reservoir depth. 

Compartmentalization analysis of faulted DFN models, however, suggests that communication 
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among joints and fault-related shear fractures can facilitate cross-formational flow, and so fault 

zones should be avoided when siting injection wells. Aligning production wells near faults, 

moreover, can help limit risk by forming pressure sinks between injectors and fault zones. 

Flow models were constructed in TOUGH2 software to determine the impact of individual 

fractures and strata-bound fracture networks on the leakage of injected CO2 from coal seams. 

Results of flow modeling in the Black Warrior Basin indicate that fracture aperture and 

connectivity are critical parameters affecting the leakage of injected CO2 from coal. Highly 

transmissive fractures near an injection well have potential to divert a large percentage of an 

injected CO2 stream away from a target coal seam. Therefore, highly transmissive fractures may 

impact the performance, efficiency, and predictability of sequestration and enhanced coalbed 

methane recovery operations. However, the strata-bound nature of Pottsville fracture systems is a 

natural factor that mitigates the risk of long-range leakage and surface seepage. DFN models 

indicate that the probability of direct communication between highly transmissive fractures in 

successive beds is low. Flow models indicate that cross-formational flow in strata-bound joint 

networks is low and is dissipated by about an order of magnitude at each successive bedding 

contact. These models help confirm that strata-bound joint networks are self-compartmentalizing 

and that the thick successions of interbedded shale and sandstone separating the Pottsville coal 

zones are confining units that protect shallow aquifers from injection operations at reservoir 

depth. 

DFN models are powerful tools for the simulation and analysis of fracture networks and can 

play an important role in the assessment of risks associated with carbon sequestration and 

enhanced coalbed methane recovery. Importantly, the stochastic nature DFN models dictates that 

they cannot be used to precisely reproduce reservoir conditions in a specific field area. Rather, 
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these models are most useful for simulating the fundamental geometric and statistical properties 

of fracture networks. Because the specifics of fracture architecture in a given  area can be highly 

uncertain, multiple realizations of DFN models and DFN-based flow models can help define 

variability that may be encountered during field operations. Using this type of approach, 

modelers can inform the risk assessment process by characterizing the types and variability of 

fracture architecture that may exist in geologic carbon sinks containing natural fractures.  

 

INTRODUCTION 

Coal is a geologic sink in which large quantities of carbon dioxide can be sequestered while 

enhancing coalbed methane recovery (Reichle and others, 1999; Gentzis, 2000; White and 

others, 2003). Discrete fracture network (DFN) models have proven useful for assessing risks to 

shallow aquifers posed by coalbed methane operations (Pashin, Jin, and Payton, 2004), and these 

models have strong potential for assessing short- and long-term leakage risks associated with 

carbon sequestration in fractured strata. DFN models are 3-D computer simulations based on the 

statistical scaling properties of natural and induced fracture systems, and these models provide a 

basis for compartmentalization analysis, pathways analysis, and flow modeling in fractured 

media (Smith and Schwartz, 1984; Dershowitz and Einstein, 1988; National Research Council, 

1996). Accordingly, DFN models can be used to assess the risks associated with carbon 

sequestration in coal by simulating fracture networks in coal-bearing strata, modeling hydrologic 

compartmentalization in these strata, defining the distribution and geometry of cross-stratal 

pathways for leakage of injected carbon dioxide from coal beds into adjacent country rock or to 

the surface, and quantifying the magnitude and timing of flow through fracture systems. 
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This report summarizes a three-year study that focused on the DFN modeling tools for coal-

bearing strata and the application of those tools to assess leakage risks associated with carbon 

sequestration in mature coalbed methane reservoirs of the Black Warrior basin in Alabama (fig. 

1). This study was conducted by the Geological Survey of Alabama in partnership with the 

University of Alabama and Jim Walter Resources, Incorporated. The software developed during 

this study is called DFNModeler and employs object-oriented programming to construct, 

visualize, and analyze DFN models. The basic approaches used in this study were (1) software 

development using commercial development tools, (2) characterization of fracture networks in 

the field and laboratory, (3) 3-D modeling and analysis of fracture systems using DFNModeler 

software, (4) flow modeling using TOUGH2 software, and (5) risk assessment based on model 

results. 

Coalbed methane reservoirs in the Black Warrior basin of Alabama (fig. 1) are among the 

most intensely studied in the world and have strong potential for carbon sequestration and 

enhanced coalbed methane recovery (Pashin and others, 2001; Pashin and McIntyre, 2003; 

Pashin and others, in press). DFNModeler software was applied to assess risks associated with 

sequestration in this basin to demonstrate the real-world application of this software, and the 

Black Warrior Basin was chosen because of the large volume of data available and because of 

the authors’ experience in the region. Pashin, Carroll, and others (2004) and Pashin and others 

(in press) determined that more than two decades of carbon dioxide emissions from coal-fired 

power plants in the basin may be sequestered in existing coalbed methane fields while increasing 

coalbed methane reserves by more than 20 percent. Coal-bearing strata in the Black Warrior 

basin and many other prospective coal basins have minimal matrix permeability, so the flow of 

water and gas is restricted primarily to fracture networks (e.g., Pashin and Hinkle, 1997; van  
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Figure 1.—Map of coalbed methane fields in the Black Warrior Basin showing location of the 

SECARB Black Warrior test site. 
 

Bergen and others, 2006). For this reason, fracture networks pose the most tangible risks for 

leakage of injected carbon dioxide that need to be assessed. The Southeastern Regional Carbon 

Sequestration Partnership (SECARB) has established a field validation test site for the Black 

Warrior Basin in Deerlick Creek Field (Pashin and Clark, 2006; Pashin and others, 2007) (fig. 1), 

and some of the models constructed in this study are based on the geology of the SECARB Black 

Warrior test site. 
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This report begins with a detailed discussion of the analytical methods used in software 

development, geological characterization, geological modeling, and flow modeling. The report 

continues with documentation for DFNModeler software, which includes an overview of the 

software architecture and instructions for the use of the software. Next is a discussion of fracture 

systems and the application of DFNModeler software to the Black Warrior Basin and the 

SECARB Black Warrior test site. The report continues with a section on flow modeling using 

TOUGH2 software and concludes with an assessment of risks associated with carbon 

sequestration and enhanced coalbed methane recovery in the Black Warrior Basin. 

 

ANALYTICAL METHODS 

Developing DFNModeler software and applying it to fracture networks required a 

multidisciplinary approach that employed a broad range of analytical methods. This section 

contains detailed descriptions of the methods used to conduct this study and is subdivided into 

three parts. The first part summarizes software development, and the second discusses the field 

and laboratory techniques used to characterize and model fracture networks in the Black Warrior 

Basin. The third part describes the flow modeling and risk assessment techniques used during 

this investigation. 

 

Software Development 

DFNModeler software was written using the Visual C++ programming language and 

includes an OpenGL visualization engine. This software was developed using Microsoft Visual 

C++ and Microsoft Foundation Class (MFC) Library under the Visual Studio .Net 2005 

programming environment. DFNModeler utilizes OpenGL graphic libraries for 3-D graphical 
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rendering of DFN models. DFNModeler is implemented with an object-orientation programming 

(OOP) model to take advantages of the OOP design paradigm and to utilize the MFC document-

view architecture to separate the data from presentations. All geological objects such fractures, 

faults, and compartments are abstracted as objects that encapsulate basic data. DFNModeler is 

therefore highly extensible and can be updated readily to refine existing capabilities and to add 

new functionality.  

The look of the user interface when the DFNModeler application is started is shown in 

Figure 2. DFNModeler was designed to have five major functions: (1) input and editing of model 

data; (2) generation of discrete fracture networks; (3) analysis of compartmentalization and fluid 

migration pathways; (4) visualization DFN modeling results; and (5) export of model data and 

results. To provide this functionality, the software was designed with a modular architecture (fig. 

3).  

A brief technical overview of the functionality and logic behind the design of DFNModeler 

software is given here, and a user’s guide for the software is given in the section on software 

documentation. A broad range of analytical methods and geological concepts were used to 

design and develop DFNModeler software and were required to develop a user-friendly software 

interface and to achieve fast computational performance.  

The first step in model development is the definition of a region, which can also be referred 

to as a fracture region. Fracture regions represent physical geologic units; that is, a lithologic unit 

or a zone of fractures as may be associated with a fault. Fracture regions are of two types: 

rectangular box and slab (fig. 4). A rectangular region commonly represents a lithologic unit, 

whereas a slab region is used to represent a dipping rock formation or an  inclined fracture zone. 

Each DFN model is composed of at least one region. Different rock units can be treated as  



 9

 

Figure 2.—Appearance of the DFNModeler software interface at launch. 

 

multiple regions. Fracture regions conceptually represent physical rock units and fracture swarms 

from a geologist’s point of view, and they also improve the efficiency of fracture generation in 

terms of computational geometry. In a DFN model, each fracture region can contain multiple 

fracture sets.  

A fracture set represents a group of fractures that have a common origin and thus similar 

geological properties. Fracture sets are distinguished from one another by (1) the fracture region 

in which they occur, (2) orientation, and (3) geological origin. If any one of the above three 

factors is different, they should be included in different fracture sets. The geometric properties of 

a fracture set are defined statistically in terms of orientation, length, height, aperture, spacing,  
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Figure 3.—Diagram showing modular architecture of DFNModeler software. 
 

and the frequency with which fractures terminate at pre-existing structures (i.e., cross-cutting 

relationships). In DFNModeler, fracture regions and fracture sets are created by entering values 

for their properties into a set of dialog boxes. Each fracture set is mapped into a specific region 

to generate fractures based on its statistical properties. A fracture set can only be assigned to one 

fracture region, whereas a fracture region can contain multiple fracture sets (fig. 5).  

In DFNModeler, fractures are generated based on statistical distributions derived from field 

and laboratory data. Once the fracture regions and sets are defined, there is enough information 

to generate DFN models. DFNModeler generates fractures using a hierarchical algorithm to 

ensure the efficiency and speed. Generation of fractures is computationally intensive given the 

thousands of fractures that a fracture set may contain. Because cleat spacing in coal can be at a 

centimeter scale, for example, there can be tens of thousands of fractures in a small area within a 

single bed. In order to efficiently generate fractures, a series of mathematical procedures have  
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Figure 4.—Diagram showing different types of fracture regions. 
 

been implemented and optimized that include (1) definition of fracture polygons and vertices, (2) 

rotation of polygons to simulate strike and dip, and (3) translation of the polygon to the proper 

location within the fracture region. Note that each parameter of the fracture is generated by its 

statistical distribution. The statistical distributions used for generating fractures are uniform,  
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Figure 5.—Multiple fracture sets simulating orthogonal joints in two fracture regions. Systematic 
joints and cross-joints were modeled as individual fracture sets in each region. The two 
fracture sets in the lower region are displayed in orange, and those in the upper region are in 
magenta. 
 

normal, log-normal, exponential, and Fisher distributions (Wood, 1994; Saucier, 2000). The 

Fisher distribution was implemented specifically for directional data used for fracture 

orientations in DFNModeler (Ulrich, 1984; Wood, 1994). All other distributions were used for 

scalar data, such as the dimensions of fractures. 

Clipping of fractures at region boundaries and at intersections with pre-existing structures 

was a critical step in the design and implementation of DFNModeler software. Because the 

centers of fractures are generated using uniform random numbers, many fractures cross the 
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region boundary and must therefore be clipped. In addition, fractures must be clipped where they 

intersect pre-existing structures to properly simulate cross-cutting relationships. Each fracture in 

DFNModeler is represented as a polygon, which in turn is represented by an array of directed 

vertices. To clip a fracture requires removing any vertices lying outside a region or beyond an 

intersected plane and inserting new vertices to honor region boundaries and geological 

relationships.  

A key functionality of DFNModeler is the ability to simulate faults (fig. 6). Faults are 

simulated in DFNModeler by specifying the location, attitude, and slip of a plane. In all cases it 

is assumed that slip occurs only along a fault plane. Therefore, the slip direction can be defined 

by its pitch within the fault plane. Pitch can be any number from 0 to 360°. Pitch of 0 or 360° 

defines a normal (dip-slip) fault, whereas 90° or 270°defines a normal fault. A reverse fault has a 

pitch of 180°, and all other numbers specify oblique slip. The cross-cutting relationship between 

a fault and fractures is determined by the sequence in which a DFN model is built. Fractures 

generated before slip is applied to a fault plane will be cut by the fault and will be translated 

according to the pitch and slip of the fault. By contrast, fractures generated after slip can cut 

across a fault.  

Compartmentalization analysis was included in DFNModeler to characterize the 

interconnectivity of fracture networks. A fracture compartment is defined as a convex 

polyhedron, or hull, that connects all vertices of intersecting fractures (fig. 7). 

Compartmentalization analysis determines if fractures intersect and how many fractures are 

interconnected to form a compartment. Compartment hulls define effective no-flow boundaries, 

and all fractures with vertices forming the hull are in hydraulic communication. The algorithms 

used for compartmentalization analysis rely on the compilation of tables of intersecting fractures.  
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Figure 6.—Simulation of faulting in DFNModeler. Top: DFN model containing fractures 
(yellow and magenta) and a dipping fault plane (red) before slip is applied. Bottom: DFN model 

after normal fault slip is applied. 
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Figure 7.—Compartmentalization model based on the DFN model of joint networks that is 
shown in Figure 5. Colored polyhedra surrounding fracture polygons are compartment hulls. 
 

Each fracture in a DFN model has its own table of interconnected fractures, and a compartment 

can be defined by performing a search of those interconnected fractures.  

Additional functions built into DFNModeler include definition of well paths and 

identification of flow pathways. The location and trajectory of wells can be defined using a basic 

dialog box that can be accessed from the menu system. After a well path is defined and 

compartmentalization analysis is completed on a DFN model, pathways analysis can be 

performed. Pathways analysis is a technique that can be used to identify compartment hulls that 
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are in communication with a well. When pathways analysis is performed in DFNModeler, all 

compartment hulls that intersect a well path are highlighted. 

DFNModeler was designed to employ a broad range of OpenGL graphical functions. DFN 

models can be zoomed and rotated in real time. Users have a high degree of control over the 

color and transparency of virtually all model elements. In addition, fractures and compartment 

hulls can be color contoured according to a variety of parameters, including volume, aperture, 

and assigned hydrologic properties. Additional functionalities of DFNModeler are described in 

the section on software documentation, and the user is encouraged to explore the software to 

discover the full range of functionality and applicability to natural fracture systems. 

 

Application to Black Warrior Basin 

A broad range of field and laboratory techniques were employed to obtain the basic data 

necessary to develop DFN models of coalbed methane reservoirs in the Black Warrior Basin, and 

the methodology used in this study was similar to that employed by the earlier study of Pashin, 

Jin, and Payton (2004). The first step was to obtain data on the type, spatial relationships, and 

size of natural fractures in the Pottsville Formation. Orientation and spacing data were derived 

from outcrops and cores. In outcrop, the orientation of fractures was measured with a Brunton 

compass, and fracture spacing and fracture height were measured by tape. Fractures were then 

classified on the bases of orientation, spacing, and host rock. Outcrops also provide information 

on the height of fractures, which was also measured by tape. Most fractures are too long to 

determine horizontal fracture length directly, so orientation and cross-cutting relationships were 

used to estimate length. 
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Cores donated by Jim Walter Resources, Incorporated (fig. 8), provided critical information 

on fracture distribution, orientation, cementation, and aperture, and data were obtained from 

2,615 joints and shear fractures in 15 cores. The dip of fractures was determined with a Brunton 

clinometer. Strike was not determined because the cores are not oriented. Aperture can be 

preserved where fractures are mineralized, and the width of mineralized fractures is typically 

referred to as kinematic aperture (Laubach and others, 1988; Stowell and others, 2001). A large 

proportion of the fractures in the Pottsville Formation are filled with calcite (Pashin and others, 

1999; Pitman and others, 2003), and kinematic aperture was measured from 433 joints and shear 

fractures. 

The statistical parameters required to construct DFN models were derived using a variety of 

spreadsheet, stereographic, and statistical software packages. The vector-mean azimuth and 

angular standard deviation of orientation data were determined using the equations of Krause and 

Geijer (1987). Dip modes of fractures were identified using stereoplots and histograms. A broad 

range of data on fracture orientation, spacing, size, and cross-cutting relationships were analyzed 

statistically, and population distributions were classified using the statistical tests of Baas (2000). 

Numerous DFN models were constructed using DFNModeler software to simulate natural 

fracture networks and induced hydrofractures in the Black Warrior Basin. The SECARB Black 

Warrior test site is at the Jobson 24-14 #11 well (State Oil and Gas Board of Alabama permit 

4001-C), which will serve as the injection well for the field test. Accordingly, the well logs and 

completion records from the Jobson well were chosen as the basis for stratigraphic control of the 

DFN models. Models were constructed to simulate joint systems in shale and sandstone, cleat 

systems in coal, and fault zones. Models were constructed at a variety of scales to display  
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Figure 8.—Map showing locations of cores used to characterize fracture networks in coal-
bearing strata of the upper Pottsville Formation. 

 

fracture architecture and to support visualization and flow modeling. The largest of these models 

simulates fracturing over a 4 square-kilometer area to a depth of nearly 800 meters (m). 

After the DFN models were completed, compartmentalization and pathways analysis were 

performed using the DFNModeler application. Compartmentalization analysis of DFN models 

enables delineation of interconnected fractures by testing for adjacency of fracture polygons 
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(Dershowitz and others, 1997). Where two or more fractures intersect, a hull (i.e., polyhedron) is 

constructed that connects the vertices of the fracture polygons. As such, a compartment hull can 

be considered as a no-flow boundary defining the limits of a reservoir compartment. Pathways 

analysis was used to identify the reservoir compartments that are contacted along specific well 

paths. 

 

Flow Modeling and Risk Assessment 

A flow model is a conceptual approximation of fluid flow processes in porous media using 

mathematical equations that include governing equations, boundary conditions, and initial 

conditions. These mathematical equations can be solved by numerical methods through the 

discretization of space and time. Because of the simplifying assumptions embedded in the 

mathematical equations and the many uncertainties in the data required by the flow model, a 

flow model must be viewed as an approximation and not an exact duplication of field conditions. 

However, even as an approximation, a flow model may be the only tool to predict, test, and 

compare a range of natural scenarios. 

Prior to CO2 injection operations, assessing the short- and long-term leakage risks associated 

with CO2 sequestration is required to ensure that operations can be conducted safely and 

effectively. Simulating multiphase CO2-H2O flow provides a means by which to quantify 

possible leakage pathways, quantify the amount of leakage that can potentially take place, and to 

characterize the relationship of flow to fracture and matrix properties. As mentioned before, 

DFN modeling relies heavily on the basic concepts of stochastic simulation. Running CO2-H2O 

flow models based on different fracture network simulations is an effective way to characterize 

the uncertainty associated with injection into fractured media. 
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ECO2N is a fluid property module for the TOUGH2_MP simulator (Zhang and others, 2004; 

Pruess and Spycher, 2007) and was selected to model the flow of CO2 and H2O in selected DFN 

models that were generated during this study using an integral difference approach. 

TOUGH2_MP is the parallel processing version of TOUGH2, which is a general purpose 

numerical simulation program for the multi-dimensional flow of multiphase, multicomponent 

fluid mixtures in porous and fractured media (Pruess and others, 1999).  

In TOUGH2, the continuum equation is discretized in space using the integral finite 

difference (IFD) method (Narasimhan and Witherspoon, 1976).  The geometric parameters for 

the flow problem are grid block volumes Vn, the interface area between grid blocks n and m Anm, 

distances Dn and Dm, and components gnm of gravity acceleration in the direction of the line 

connecting nodal points n and m (fig. 9). A key advantage of the IFD technique for space 

discretization is that all geometric quantities are defined locally so there is no need to make 

reference to a global system of coordinates. A grid block n can be connected to many grid blocks 

m (m = 1, 2, etc.), and unstructured grids may be used. In addition, connected grid blocks do not 

need to be neighboring. These properties provide great flexibility when dealing with irregular 

features such as fractures in a flow model. Further details can be found in the TOUGH2 user’s 

manual (Pruess and others, 1999).  

ECO2N provides capabilities for modeling advection and diffusive flow and transport in 

multidimensional heterogeneous systems containing mixtures of H2O, NaCl, and CO2 (Pruess, 

2005). In this study, only the flow of H2O and CO2 was modeled because the salinity of 

formation fluid in the study area is low (Pashin and others, 1991). Two phase conditions were 

modeled in ECO2N. One is an aqueous phase that is mostly water but may contain some 

dissolved CO2, the other is CO2-rich phase (gas or liquid) that is mostly CO2 but may contain  
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Figure 9.—Space discretization and geometry data in the integral finite difference method 
(modified from Pruess, and others, 1999). 

 

some water.  Importantly, H2O is the wetting phase and CO2 is non-wetting phase. Depending on 

pressure-temperature conditions, CO2 was modeled as a gaseous or liquid phase. 

Modeling flow in fractured reservoirs remains a challenge, although the basic behavior of 

fractured reservoirs has been modeled for many years (Warren and Root, 1963). Where fracture 

density is not high, some traditional methods like dual porosity and dual permeability may not be 

suitable. To properly represent DFN models, individual fractures need to be represented 

explicitly in the flow model. Flow can be modeled simultaneously along fractures and within 

rock matrix using the methods employed herein. In this study, discrete fractures were 

superimposed on porous rock matrix following the procedures of Zhang and others (2004). Thus, 

where fractures exist in a given domain, two kinds of grid blocks were used. One set of grid 

blocks was used to represent porous rock matrix, and the other set was used to represent fracture 

networks. The dual permeability concept was employed in this study to consider interactions 

within and between fractures and matrix.  
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The flow models developed in this study are based on multilayered models that simulate coal 

seams and joint networks. The DFN models were generated in DFNModeler and exported to 

ECO2N. The flow models were run using the methods discussed above, and the results were 

used to evaluate risks associated with the injection of CO2 in coal-bearing strata. Key factors 

considered during flow modeling were the effects of individual fractures on leakage of injected 

CO2 from coal, the effects of strata-bound fracture networks on reservoir leakage, and the nature 

and magnitude of risks associated with leakage of injectate. 

Risk assessment was performed based on the results of DFN modeling, compartmentalization 

analysis, pathways analysis, and flow modeling. Key factors considered in risk assessment are 

the proximity of hydraulically conductive fractures to the injection point, the effects of strata-

bound and trans-stratal fractures on fluid transport, and the effects of fault zones on reservoir 

continuity and cross-formational flow. An important goal of risk assessment was to evaluate the 

applicability of DFN models to carbon sequestration and enhanced coalbed methane recovery 

programs and to identify areas where DFN modeling tools can be improved. 

 

SOFTWARE DOCUMENTATION 

DFNModeler is a Windows application that can be used to generate and analyze discrete 

fracture networks. DFNModeler is designed to have 5 major functions: 1) input and editing of 

model data; 2) generation of discrete fracture networks; 3) analysis of compartmentalization and 

fluid migration pathways; 4) visualization of DFN modeling results; and 5) import and export of 

model data and results. A brief overview of these functions is given below: 
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Model Data 

Data for DFN modeling are composed of fracture properties, fracture region properties, and 

rock matrix properties. Fracture properties commonly include statistical data on fracture 

orientation, cross-cutting relationships, fracture size and spacing, and hydrologic properties, such 

as aperture, transmissivity, and storativity. Fracture region properties include the geometry and 

orientation of the region containing a fracture system. A fracture region is defined as a geometric 

unit where fracture sets have the same statistical properties. Rock matrix properties include basic 

hydrologic properties, such as porosity, permeability, transmissivity, and storativity. 

 

Generation of Discrete Fracture Networks 

Once the data required to build a discrete fracture network have been entered, the next step is 

to generate a computer model of the fracture network. DFNModeler uses efficient algorithms to 

generate fracture populations and to simulate cross-cutting relationships between and among 

fractures. This allows the user to rapidly generate multiple realizations of fracture networks from 

a given set of input variables that can be used to characterize fracture architecture and to develop 

flow models. 

 

Compartmentalization and Fluid Migration 

Compartmentalization is an important measure of the interconnectivity among fractures. 

Compartmentalization analysis determines how far fractures at different stratigraphic levels can 

be interconnected and therefore provides us with information about how fluid can migrate and 

where effective no-flow boundaries may lie. A compartment is defined as a convex polyhedron, 

or hull, that connects the vertices of intersecting fractures. As the definition implies, fractures 
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from different compartments are isolated from each other and thus fluid migration is 

hydrologically confined within the compartment boundaries. 

Fluid pathway analysis is associated with wells penetrating different compartments. Fluid in 

one compartment can be transported into other compartments through a well which is open to 

multiple stratigraphic horizons or geologic structures, such as faults. Therefore, DFNModeler 

will determine if and how well placement may affect hydrologic communication among 

compartments that are separated geologically. All compartments that are connected to a well 

define the pathway of fluid migration from one compartment to another. For visual display, 

DFNModeler highlights compartments that are interconnected along a well path. 

 

Visualization 

DFNModeler enables visualization of modeling results with the help of OpenGL graphic 

rendering techniques. OpenGL allows real-time 3-D zooming, translation, rotation, and scaling 

of a DFN model. Apart from these standard visualization operations, DFNModeler can also 

color-contour fracture properties such as aperture, transmissivity, and storativity. In addition, 

variables such as color map and transparency can be customized. 

 

Import and Export 

Import and export functions are also implemented to enable DFNModeler to communicate 

with other modeling packages. Files can be imported from other DFN modeling software 

packages, such as Golder Associates FracMan. DFNModeler lacks flow modeling and solute 

transport capabilities, so data must be exported to other software packages for this purpose. The 

ECO2N module of TOUGH2 software was used for flow modeling in this study, and so the 
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export function in DFNModeler translates fracture data into a text format that can be read by 

TOUGH2. 

 

System Requirements 

DFNModeler can be run on most modern personal computers and was designed with modest 

system requirements in mind. System requirements to run DFNModeler are as follows: 

• A personal computer with the Microsoft Windows 2000 or Windows XP operating 

system installed (not tested with Microsoft Windows Vista). 

• Microsoft Windows-compatible CPU with clock speed of 2.2 gigahertz or faster 

recommended. 

• System RAM of 1.0 gigabytes or higher. 

• OpenGL-capable graphics card with at least 32 megabytes of VRAM recommended (ATI 

Radeon X300 or better). 

 

Menu Structure 

DFNModeler employs a hierarchical menu system that provides users convenient access to 

all major software functions. The menu system is composed of seven main menu items that can 

be selected at the top of the main application window (fig. 2). Clicking on a menu item reveals a 

pull-down menu that displays specific software functions and sub-menus as is typical of software 

packages run under Microsoft Windows operating systems. A summary of each menu and its 

submenus is given below: 
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File Menu 

The File menu allows users to create, open, close, or save any DFNModeler project (fig. 10). 

This menu also allows users to import fracture-related data and to export DFN models to 

TOUGH2 for flow modeling. Print functions, although listed in the menu, are currently not 

supported because there is no default support in the MFC library for OpenGL-rendered graphics. 

However, the user can take screen images of the modeling results by using the Print Screen 

function that is accessible directly from the keyboard of computers employing Microsoft 

Windows operating systems. At the bottom of the menu is the Exit item, which enables users to 

exit from DFNModeler into the main Windows operating environment.  

 

View Menu 

The View menu in DFNModeler serves a variety of purposes ranging from controlling the 

display of toolbars to manipulating the appearance of DFN models (fig. 11). The upper items in 

this menu can be used to toggle a toolbar that provides simple access to many file functions and a 

status bar that shows the state of the model display.  

The DFN Model menu item enables display of model elements, such as fracture regions, 

fracture sets, and compartments. This item further enables color mapping and display of fracture 

attributes, such as aperture, transmissivity, and storativity. The Model Frame item provides 

control over the appearance of the model frame, which is the box bounding the DFN models.  

Edit/View Mode toggles real-time manipulation and editing of DFN models. The lower part 

of the menu provides control over the appearance of DFN models and enables zooming, rotation, 

and vertical exaggeration of model realizations. The Home View item enables users to return to 

the default view that is used when models are initially displayed. 
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Figure 10.—Screen image of the File menu in DFNModeler. 
 

 

Figure 11.—Screen image of the View menu in DFNModeler. 
 

Data Menu 

The Data menu provides access to the basic tools for the construction and editing of DFN 

models (fig. 12). Parameters set under each menu item can be saved from within the data entry 

dialogs. The Model Definition menu item brings up a dialog box where users can define the 

boundaries and shape of a DFN model. The Region item brings up a dialog to define and 

parameterize fracture regions, and the Fracture Set item brings a dialog to define and 
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Figure 12.—Screen image of the Data menu in DFNModeler. 
 

parameterize fracture sets. The Well menu item is used to define well paths, and the Fault item 

invokes a dialog box to define the orientation and slip of faults.  

 

Model Menu 

The Model menu (fig. 13) contains a set of menu commands that drive realization of a DFN 

model based on the parameters imported using the File menu or entered using the Data menu. 

The Initialize Seed menu item enables definition of a numerical seed that initializes a DFN 

model. To construct different realizations based on the same geologic parameters, users can enter 

different numerical seeds. Construction of models using the identical geologic parameters and 

numerical seeds will result in identical models. 

The Realize menu item generates DFN models based on a given set of geologic parameters 

and a given numerical seed. Submenus under the Realize item enable realization of fractures, 

faults, and wells. After a model is realized, users can perform compartmentalization analysis and 

then fluid pathway analysis. Invoking the Compartment Analysis menu command results in the 

generation of compartment hulls in and around the DFN model. If well paths and compartment 

hulls have been generated, then the Pathway Analysis menu command can be used to highlight 

the compartments that are contacted by a well path. 
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Figure 13.—Screen image of the Model menu in DFNModeler. 

 

Tools Menu 

The Tools menu facilitates customization of the appearance of the DFN models generated in 

DFNModeler (fig. 14). The Preferences menu item invokes a dialog box where default settings 

for lighting, color, and transparency can be assigned. The Lighting command enables definition 

of the type, intensity, and position of the virtual light sources that illuminate the DFN models. 

The Color Scheme command, by comparison, enables refinement of the color scheme used for 

model elements, such as regions, fracture sets, and compartment hulls. 

 

Window Menu 

The Window menu provides the standard window display options that are common to most 

applications running under Microsoft Windows operating systems (fig. 15). The upper part of the 

menu facilitates control over the arrangement of windows within the DFNModeler application. 

The bottom of the menu lists the windows that are open, and a check mark denotes the window 

that is currently active. 

 

Help Menu 

The Help menu (fig. 16) has been partially implemented in DFNModeler. The Help Topics 

item is currently inactive, and the user is therefore referred to this guide for information on the  
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Figure 14.—Screen image of the Tools menu in DFNModeler. 
 

 

Figure 15.—Screen image of the Window menu in DFNModeler. 
 

 

Figure 16.—Screen image of the Help menu in DFNModeler. 
 

capabilities and used of DFNModeler software. The About DFNModeler item launches a 

window displaying the version information for the copy of DFNModeler that is running.  

 

Data Entry and Editing 

In DFNModeler, nearly all data entry and editing of data sets is performed through the Data 

menu (fig. 12). Each menu item invokes a dialog box where data can be entered and edited. This 

section focuses on the entry and editing of data using these dialog boxes.  
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Model Definition 

The Model Definition menu item (fig. 12) invokes a dialog box where DFN models can be 

named and defined (fig. 17). A name can be applied to a DFN model in the Model Name field in 

the upper part of the dialog box. The size of the model, which is defined in units of meters, can 

be specified in the Model Size field. Clicking OK saves the model definition, whereas clicking 

Cancel dismisses the dialog box without saving the most recently entered information. 

 

Defining Fracture Regions 

The Region menu command (fig. 12) invokes a dialog box that enables the definition of 

fracture regions (fig. 18). Fracture regions are listed in the region list field in the upper-left part 

of the dialog box. New regions can be created by clicking the Create New Region button, which 

brings up an additional dialog box where the region can be named (fig. 19). Regions can be 

deleted by clicking the Delete Region button (fig. 18). Regions can be imported from existing 

data files using the Load Regions button. All changes made to the region list can be saved for 

future use by using the Save Regions button. 

A stratigraphic name can be applied to a region in the Stratigraphy field in the upper part of 

the dialog box (fig. 18). Below this is a pull-down menu that can be used to assign the region as a 

box or slab region (see fig. 4). The remaining data entry fields are used to define the position, 

size, and orientation of the fracture region (fig. 18). Click the Update Region Properties button to 

save the data entered for each region. Clicking the OK button in the lower-left part of the dialog 

box will save all changes and dismiss the dialog box, whereas clicking Cancel will dismiss the 

dialog box without saving changes. 
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Fig. 17.—Model Definition dialog box. 

 

 

Fig. 18.—Dialog box used to create fracture regions. 
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Figure 19.—Dialog box used to name fracture regions. 
 

Defining Fracture Sets 

Selecting the Fracture Set command in the Data menu (fig. 12) brings up a dialog box that 

enables the definition and parameterization of fracture sets. In the upper part of the dialog box is 

a list of available fracture sets (fig. 20). Clicking the Create button brings up a dialog box where 

a new fracture set can be named (fig. 21). Clicking the Load button (fig. 20) invokes a dialog box 

where existing fracture set files can be loaded. The Save Data button is used to save fracture sets 

defined during the current session. 

The Location Model field in the upper-right part of the dialog box (fig. 20) is used to assign 

fracture sets to fracture regions. A fracture set must be assigned to a fracture region in order for it 

to be generated by DFNModeler. Clicking the Assign button brings up a list of available fracture 

regions. If an appropriate fracture region is not available, clicking the Create button brings up the 

region creation dialog box described in the previous section. 

Fracture orientation is defined in the Orientation field. The user can enter trend (strike) and 

dip of any fracture set that can be selected from the Fracture Set List field. Fracture distribution 

can be uniform or can follow a Fisher (normal) distribution. If a Fisher distribution is selected, a 

concentration parameter (K1) must be entered. As the value of K1 increases, the orientation of  
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Figure 20.—Dialog box used to define and parameterize fracture sets. 
 

 

Figure 21.—Dialog box used to name a fracture set. 
 

individual fractures will vary less. If a uniform distribution is selected, all fractures will have the 

same orientation.  

Fractures can be generated by three methods. Selecting Use # of Fractures will assign a 

specific number of fractures to a given fracture set within a fracture region. Using Fracture 

Spacing will distribute fractures throughout the model based on fracture spacing. The third 
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option uses the P32 parameter of Dershowitz and others (1999). Only the first method is 

currently implemented in DFNModeler, and the other methods will be implemented in future 

versions. 

The Fracture Width and Fracture Height fields can be used to define the basic dimensions of 

fractures within a fracture set. Width, also known as length, can be used to specify the horizontal 

dimension of fractures parallel to trend or strike, and height can be used to specify the vertical 

dimension of fractures. The Distribution fields can be used to specify the appropriate statistical 

distributions for width and height, specifically uniform, log normal, exponential, and power-law. 

Appropriate parameters, such as the mean and standard deviation of the statistical distribution 

can be entered below the Distribution field. 

The  aperture, transmissivity, and storativity of fracture networks can be assigned using the 

three appropriate buttons in the Hydraulic Properties field in the lower part of the dialog box. 

Clicking each button brings up a dialog box that enables the definition of these hydraulic 

properties according to a series of statistical parameters. 

The user must click the Update button to save all changes made to each fracture set during 

the current session. The OK button can be used to dismiss the dialog box while accepting 

changes to the fracture set that is currently displayed, whereas the Cancel button can be used to 

or dismiss the dialog box without accepting changes. 

 

Defining Wells 

Choosing the Well item from the Data menu (fig. 12) launches a dialog box that enables 

users to define well paths (fig. 22). Wells can be named in the Name field in the upper part of the 

dialog box.  The Well Location field enables users to determine the position of the well within in  
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Figure 22.—Dialog box to define well paths in DFNModeler. 
 

the DFN model. The Well Attitude field enables users to specify the trend (bearing), plunge, and 

length of the well path. 

Complex well paths can be simulated as a series of straight wells using this dialog. For 

example, a curved well path can be simulated by defining a series of wells in which plunge 

decreases with depth. In many circumstances, it is desirable to simulate a complete wellbore 

length for the purpose of visualization and to simulate only the parts of the well that are open to a 

reservoir when conducting pathways analysis, which is discussed later in this documentation in 

the section on modeling and analysis. 

 

Defining Faults 

Choosing the Fault item from the Data menu (fig. 12) invokes a dialog box that enables 

definition of fault parameters (fig. 23). At the top of the dialog is the Name field, which can be 

used to name and identify faults. The location and attitude of the fault plane can be specified in 

the middle part of the dialog box. Fault location is defined on the basis of x, y, and z coordinates  
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Figure 23.—Dialog box used to define faults. 
 

as expressed in meters, and fault attitude is defined in terms of dip direction (azimuth) and dip as 

expressed in degrees. Users further have the option of defining fault attitude using the pole to the 

fault plane.  

In the lower part of the dialog box is the Slip Information field, which defines fault slip in 

terms of the angle of pitch in degrees and the magnitude of slip in meters. Clicking the OK 

button saves the information in the dialog box and dismisses the box, whereas clicking Cancel 

dismisses the dialog box without saving the changes. 

 

Import and Export 

Data can be imported to and exported from DFNModeler by choosing Import or Export from 

the File menu (fig. 24). Three types of data can be imported into and exported from 

DFNModeler. Fracture set data from DFNModeler and FracMan can be imported as .fab files,  
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Figure 24.—Screen image showing import functionality in DFNModeler. 
 

which are in a format defined for FracMan software by Dershowitz and others (1999). In 

addition, fault data and well data developed in DFNModeler can be imported. All data are 

exported as binary data files. These import and export functionalities enable DFNModeler to 

communicate with other DFN modeling software packages, such as FracMan and with flow 

modeling packages like TOUGH2. 

 

Visualization Tools 

DFNModeler makes use of an advanced OpenGL visualization engine and provides with a 

diverse set of visualization tools that can be used to manipulate and customize DFN models. 

Most visualization functions can be accessed through the View menu (fig. 25). Alternatively, the 

functions of the View menu can be accessed through the contextual menu system with a right-

click of the mouse. 

The first step in visualization is to use the Realize functions of the Model menu (fig. 13). The 

Realize menu item leads to a submenu in which key model elements, such as regions, fracture  



 39

. 

Figure 25.—Menu choices for displaying DFN models. 
 

sets, faults, and wells, can be displayed. Upon selection of the items in the submenu, model 

elements are drawn in the model display area in the right-hand side of the DFNModeler 

application interface (fig. 2). 

After model elements are realized, the appearance of those elements can be controlled by 

using the DFN Model menu item of the View menu (fig. 25). The DFN Model menu command 

leads to a hierarchical set of submenus that controls key model attributes. The Fractures submenu 

enables toggling and color contouring of fracture sets. Toggling fractures on and off is useful 

when viewing complex DFN models where fractures may clutter the view of key model 

elements, such as fracture compartments, faults, and well paths. The Normal Fractures command 

displays fractures with specified colors and transparency. This command is useful for restoring 

fracture sets to their original appearance after color contouring fractures according to attributes, 

such as aperture or transmissivity. To color contour fractures by attributes, such as aperture (fig. 

26), transmissivity, or storativity, simply select the Contour Aperture, Contour Transmissivity, or 

Contour Storativity command from the Fractures submenu (fig. 25). 
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Figure 26.—DFN model contoured by fracture aperture 
 

The Regions submenu allows users to set preferences for the display of fracture regions. This 

command launches the Object Display dialog box, which contains numerous options for 

customizing model elements (fig. 27). The DFN Object Type field contains a pull-down menu 

that lists the types of model elements, such as fracture regions, fracture sets, and compartments, 

that can be manipulated using this dialog box. In this case, fracture regions are selected, and a list 

of available fracture regions is listed in the Fracture Regions field. Fracture regions can be 

selected for manipulation directly by using the mouse, and all regions can be selected using the 

Select All button. The Refresh button can be used to deselect all items in the Fracture Regions 

field. 
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Figure 27.—Object Display dialog box. 
 

A large number of operations can be performed using the buttons in the lower part of the 

Object Display dialog box (fig. 27). Selected fracture regions can be displayed by clicking the 

Show button or can be hidden using the Hide button. The Show Frame button is to display a 

frame outlining selected regions, and the Hide Frame button will hide the frames of selected 

regions. The Fill Frame button fills selected regions with a specified color, and the Unfill Frame 
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button can be clicked to remove the fills. The Apply Transmissivity Threshold check box can be 

selected to display only fractures with transmissivity above a given threshold. This enables users 

to omit low-transmissivity fractures from DFN models and can further be used to reduce the 

number of fractures prior to the calculation of reservoir compartments, which can be time-

intensive in extremely large DFN models. The Set Details button launches a dialog box that 

enables users to define the transmissivity threshold and to assign color and transparency to each 

region. Through the Set Details dialog or the Tools menu, users can access another dialog box to 

specify the color and transparency of selected DFN model components by using a color picker or 

sliding RGB color and transparency controls (fig. 28). Clicking the Done button will dismiss the 

Object Display dialog box (fig. 27). 

Options available under the Compartments submenu of the DFN Model menu item are 

similar to those available under the Fractures submenu (fig. 25). For example, compartment hulls 

can be toggled on and off. A key feature is the ability to color contour compartments by volume. 

Using the Normal Compartment command restores the color-contoured compartment hulls to the 

original colors. DFNModeler further provides control over the appearance of fluid pathways and 

wells using tools similar to those discussed above. 

The easiest way to translate, zoom, and rotate DFN models is with the mouse and keyboard. 

To translate a DFN model within the model window, position the pointer within the window, 

press and hold the left mouse button, and move the mouse. To zoom in and out, press and hold 

the right and left mouse buttons simultaneously and move the mouse. Moving the mouse forward 

zooms in, whereas moving in backward zooms out. Models can be rotated by pressing and 

holding the left mouse button while pressing and holding the CTRL key and moving the mouse.  
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Figure 28.—Color Selection dialog box. 
 

The user can combine the above operations to visualize any part of the model at the desired 

detail. 

Controls for the zoom, rotation, and vertical exaggeration of DFN models are also available 

in the lower part of the View menu (fig. 25). Selecting the Zoom In and Zoom Out menu items 

can be used to control zoom in pre-set increments. The Home View menu command returns the 

size and orientation of the DFN model to default parameters. Rotation can be specified manually 

relative to X, Y, and Z components in degrees, and the Vertical Exaggeration command brings 

up a dialog box where the vertical exaggeration of a DFN model can be specified.  
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Modeling and Analysis 

DFNModeler provides an array of tools for the modeling and analysis of fracture networks, 

and much of this functionality can be accessed through the Model menu (fig. 13). Key modeling 

and analytical functions available in DFNModeler include the construction and visualization of 

DFN models, compartmentalization analysis, and pathways analysis.  

The Initialize Seed menu item (fig. 13) enables definition of a numerical seed that initializes 

a DFN model. To construct different realizations of DFN models based on a single set of 

geologic parameters, users can enter different numerical seeds. Construction of models using the 

identical geologic parameters and numerical seeds will result in identical models. 

The Realize menu item (fig. 13) generates DFN models based on a given set of geologic 

variables and a given numerical seed. Submenus under the Realize item enable realization of 

fractures, faults, and wells. After a model is realized, users can perform compartmentalization 

analysis and then fluid pathway analysis. After a model is realized, users have access to the full 

suite of analytical tools described earlier in the section on visualization tools. Some important 

analytical capabilities, such as the color contouring of fractures by aperture, transmissivity, and 

storativity can be accessed through the View menu (fig. 25). 

After a DFN model is realized, advanced functions, such as compartmentalization analysis 

can be performed. To perform compartmentalization analysis, simply go to the Model menu and 

select the Compartmentalization command (fig. 13). A progress bar will appear showing the 

status of the compartmentalization analysis, and compartment hulls will be drawn in the DFN 

model after the progress bar disappears (figs. 7, 29). Before performing compartmentalization 

analysis, be sure that all desired model elements are shown in the visualization window.  
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Figure 29.—Compartmentalization model with compartment hulls color contoured by volume. 
 

Compartmentalization analysis can be performed on a completed DFN model or a partial 

DFN model. One approach that may be useful is to perform Compartmentalization on a complete 

DFN model to analyze the degree of structural interconnectivity in a fracture network and then 

apply a series of transmissivity thresholds using the Object Display dialog box (fig. 27) to 

analyze hydraulic interconnectivity. After hulls are drawn, users can customize color and 

transparency using the Object Display dialog box or can color contour the hulls according to 

volume using the submenus of the View menu (fig. 25). 

Fluid pathway analysis is performed by selecting the Pathway Analysis function in the Model 

menu (fig. 13). Importantly, pathway analysis can be performed after compartmentalization 

analysis and only on DFN models containing at least one well. After the Pathway Analysis 
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function is selected, a dialog box will appear that contains a list of available wells and some view 

options. Simply select a well, and the compartment hulls in contact with that well will be 

highlighted (fig. 30). The model can then be zoomed and rotated to examine intersections of 

highlighted compartment hulls with other wells. Selecting additional wells, moreover, helps 

determine if wells share common flow pathways or if they are in hydraulic communication with 

unique reservoir compartments. 

 

 

Figure 30.—Dialog box and DFN model showing results of pathways analysis. 
 

APPLICATION TO BLACK WARRIOR BASIN 

This section reviews the application of DFNModeler software to coalbed methane reservoirs 

of the Black Warrior Basin and the SECARB Black Warrior test site. Throughout this section, 

readers are encouraged to consider the techniques used in this study and how they can be adapted 

and applied to other sedimentary basins with coalbed methane and carbon sequestration 

potential. The discussion begins with an analysis of the geology and statistical properties of the 

fracture networks that form the basis of the DFN models. Next, the discussion turns toward 
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simulation of the SECARB test site using DFNModeler software. Following this, the discussion 

concludes with compartmentalization analysis and pathways analysis of the DFN models.  

 

Pottsville Fracture Networks 

Economic coal resources in the Black Warrior Basin are concentrated in the upper Pottsville 

Formation (Lower Pennsylvanian), and coalbed methane production is restricted to the eastern 

part of the basin in Alabama (fig. 1). The upper Pottsville constitutes a succession of shale, 

sandstone, and coal that ranges in thickness from 600 to more than 1,400 m (fig. 31). Coal beds 

are generally thinner than 3 m, and beds as thin as 0.3 m are targets for coalbed methane 

production (e.g., Pashin and Hinkle, 1997; Pashin, 1998, 2007). Pottsville coal beds are clustered 

in coal zones, and each coal zone caps a marine-terrestrial depositional cycle (e.g., McCalley, 

1900; Pashin, 2004). Coalbed methane is most commonly produced from the Black Creek, Mary 

Lee, and Pratt coal zones, although younger coal zones are productive in parts of the basin. 

Upper Pottsville coal zones are separated by coarsening-upward intervals of interbedded shale 

and sandstone that are between 10 and 120 m in thickness. 

Pottsville strata in the eastern Black Warrior basin are folded, faulted, and fractured, and 

these types of geologic structures have a significant impact on reservoir properties (e.g., 

Semmes, 1929; Pashin and Groshong, 1998). The Pottsville Formation forms a structural 

homocline that dips southwest and contains numerous superimposed folds and faults (Semmes, 

1929; Thomas, 1988) (fig. 32). Folds of the Appalachian thrust belt are superimposed on the 

southeast margin of this homocline. The axial traces of these folds strike northeast and include 

the Sequatchie anticline, the Coalburg syncline, and the Blue Creek anticline. The southwest-

dipping homocline is broken by a multitude of normal faults that generally strike northwest.  
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Figure 31.—Core log and geophysical well log showing the stratigraphic section of the upper 
Pottsville Formation in the Black Warrior coalbed methane fields  

(modified from Pashin and Hinkle, 1997). 
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Figure 32.—Structural contour map of the top of the Pratt coal zone in the Black Warrior 
coalbed methane fields (modified from Pashin, Carroll, and others, 2004). 

 

Trace length of the subsurface-mappable faults ranges from about 1 to 13 kilometers (km). Strike 

of the faults averages about N. 30° W. and ranges from N. 7° W. in the backlimb of the 

Sequatchie anticline to N. 54° W. in farther west in the interior of the basin. The faults constitute 

a horst and graben system, and dip of the faults is generally between 50 and 70°. 

The shale, sandstone, and coal of the upper Pottsville in the Black Warrior coalbed methane 

fields have effectively no matrix permeability to water (Pashin and Hinkle, 1997). Accordingly, 

natural fractures are the primary hydrologic conduits in these strata. Fracture networks in the 
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upper Pottsville include joints, cleats, and fault-related shear fractures (Ward and others, 1984; 

Pashin, Jin, and Payton, 2004) (fig. 33). Cleat systems are the principal source of permeability in 

coal, whereas joints and fault-related shear fractures in the intervening strata potentially provide 

avenues for cross-stratal flow. Each type of fracture has distinctive geologic and statistical 

attributes, and these attributes are discussed in detail below. 

 

Joints 

Joints are widespread in shale and sandstone and are typically spaced between 0.5 and 10 m. 

Joint systems in the Pottsville Formation form orthogonal sets of near-vertical fractures 

composed of systematic joints and cross joints (Ward and others, 1984; Pashin and others, 1999; 

Pashin, Jin and Payton, 2004) (fig. 34). Systematic joints are planar and can have surface traces 

on the order of 100 m. Cross joints are shorter than systematic joints, tend to strike perpendicular 

to systematic joints, and commonly terminate at intersections with systematic joints.  

Systematic joint systems can maintain consistent orientations in the eastern Black Warrior 

basin (Ward and others, 1984) (fig. 35). Joints in sandstone and shale have been subdivided into 

a regional joint system and a localized joint system that is restricted to the area containing 

Appalachian folds (fig. 35A). Systematic joints of the regional joint system strike with a vector 

mean azimuth of N. 47° E., whereas systematic joints of the fold-related system strike with a 

vector mean azimuth of N. 64° W. Observations from underground coal mines indicate that the 

regional joint systems persist at reservoir depth (Ward and others, 1984), and these joint systems 

are the primary focus of this study. The regional joint system apparently formed in a basinwide 

stress field stress-release fractures, whereas the localized joint system formed in response to 

stresses within Appalachian folds (Ward and others, 1984; Pashin and others, 1999). In addition  
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Figure 33.—Photograph of a mine highwall showing relationships among cleated coal seams, 
jointed shale and sandstone, and a normal fault with associated fault-related shear fractures. 

 

to regional and fold-related joint systems, near-surface joint systems and bed-parallel partings 

that are associated with local topography have been identified in the Black Warrior Basin 

(Pashin, Jin and Payton, 2004). These shallow fracture systems are not considered in the current 

study because they apparently do not reach reservoir depth. 

A series of abandoned mine highwalls (secs. 30 and 31, T. 18 S., R. 8 W.) in the Brookwood 

coal zone north of the SECARB Black Warrior test site was used to constrain joint orientation. 

Fractures in the highwalls are dominated by systematic joints that strike with a vector-mean 

azimuth of N. 47° E., which is consistent with the regional joint system (fig. 36). Systematic 

joint orientation has a Gaussian distribution with a standard deviation of 20°. Cross joints are 

relatively sparse in the highwalls and have an angular standard deviation of 24°. 
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Figure 34.—Photograph of mine highwall showing systematic joints and cross joints in a thick 

marine mudstone interval. 
 

Joints in the Pottsville Formation dip steeply (figs. 34, 37). Analysis of the dip of 715 joints 

in the 15 cores analyzed shows a strongly skewed distribution with a mean dip of 85° and a 

standard deviation of 5° (fig. 37). These fractures can indeed be considered geologically vertical, 

considering that the median dip is 87° and the modal value is 90°. Variability of joint dip is 

interpreted in part to represent curvature of joint surfaces, and core data are biased by the 

probability that drilling will intersect dipping joint segments rather than vertical segments.  

Height, length, spacing, and cross-cutting relationships are critical variables for the 

simulation of joint networks. Where the full height of joints in the Pottsville Formation can be 

observed, they tend to be strata-bound; that is, they terminate at or near bedding contacts (fig. 

38). Of the 723 joints analyzed in core, 197 (27 percent) had length sufficient to determine the  
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Figure 35.—Generalized map showing joint and cleat systems in the Pottsville Formation 

(modified from Pashin and others (1991). 
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Figure 36.—Rose diagram showing orientation of systematic joints and cross joints in mine 
highwalls in Blue Creek Field. 

 
 

 
 

Figure 37.—Histogram showing dip of joints measured in wireline cores. 
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Figure 38.—Photograph showing strata-bound joints in flaggy sandstone beds. Note that joint 
spacing increases with bed thickness. 

 

relationship to bedding and other fractures. Of these, 178 joints (90 percent) are contained within 

individual shale or sandstone beds, and only 16 joints (8 percent) cross bedding contacts. Only 3 

joints (1.5 percent) terminate at fracture intersections. Strata-bound joint systems are common in 

sedimentary rocks and indicate that beds were fractured with a degree of mechanical 

independence as dictated by their individual geomechanical properties (Pollard and Aydin, 

1988). Considering the predominance of strata-bound joint systems in the Pottsville Formation, 

the equivalence of joint height to bed thickness is a baseline hypothesis that can be used to 

construct DFN models.  

Most joints are too long to determine length directly, but cross-cutting relationships can be 

used to estimate joint length. Fracture intersections can be classified as X-type where they cross, 

T-type where one fracture intersects at another at a high angle, and J-type where one fracture 

curves to intersect another with similar orientation (Pashin, Jin, and Payton, 2004) (fig. 39). 

About 90 percent of the joint intersections observed in the area of the Black Warrior Basin  
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Figure 39.—Photographs showing types of fracture intersections. 
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containing only the regional joint system are T-type intersections. Therefore, cross-joint length 

tends to equal systematic joint spacing.  Systematic joints are closely aligned and were not 

observed to cross in the study area. Instead, where closely aligned joints approach, either one 

fracture will curve and terminate against another to form a J-type intersection, or a fracture will 

simply terminate within the rock mass without intersecting another fracture. Accordingly, 

systematic joint length can be constrained by spacing, angle of approach, and the frequency of 

simple termination within the rock mass.  

Limited exposure and a scarcity of bed-parallel fracture pavement makes rigorous analysis of 

joint spacing difficult. However, an exceptional data set from a siderite bed at the Bankhead 

Lock and Dam (SE 1/4, sec. 22, T. 18 S., R. 8 W.) suggests that the spacing of joints within 

individual beds can be modeled using log-normal distributions (fig. 40A). Median joint spacing 

typically increases with increasing bed thickness (Verbeek and Grout, 1984). Based on 

observations from 26 beds in various outcrops in the eastern Black Warrior Basin, joint spacing 

has a logarithmic distribution (fig. 41). A consequence of this distribution is that joint spacing is 

substantially greater than bed thickness in thin beds, which gives the beds a flaggy appearance 

(fig. 38), and is substantially less than bed thickness in thick beds, which imparts a columnar 

appearance (fig. 34). One shortcoming of this study, however, is that limited sampling 

opportunities do not permit the derivation of separate spacing-thickness relationships for 

sandstone and shale. 

Mineral cement was observed in 30 percent of the joints studied in core. Calcite is the 

dominant fracture-filling cement in Pottsville joint systems (e.g., Pashin and others, 1999; 

Pitman and others, 2003) and was identified in 98 percent of the mineralized fractures (fig. 42A). 

Pyrite and clay (kaolinite) are accessory fracture-filling minerals. Cement covers more than 80  
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Figure 40.—Histograms and percentile plots demonstrating statistical properties of joint and 
cleat spacing. 

 

percent of fracture surfaces in most mineralized segments of joints (fig. 43A), indicating that 

mineralization can limit flow within joint systems. However, about 40 percent of the mineralized 

fractures have cement coverage between 1 and 80 percent, indicating that significant porosity 

exists within many mineralized joint segments. Based on the observations from core, it appears 

cement has a patchy distribution in Pottsville joint networks and that, provided aperture exists 

along nonmineralized segments, most joints have capability to support flow. 
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Figure 41.—Scatterplot showing logarithmic relationship between joint spacing and bed 
thickness in outcrops of the Black Warrior Basin. 

 

Most calcite fracture fills in the Pottsville are simple and been interpreted as the product of a 

single post-kinematic mineralization event that preserves fracture aperture (Pitman and others, 

2003; Pashin, Jin, and Payton, 2004). Indeed, the multiple crack-seal textures and fracture-filling 

breccia that are characteristic of polyphase fracturing and mineralization were observed only in 7 

joints. Percentile plots of kinematic aperture, as interpreted from the thickness of simple joint 

fills, can be characterized using exponential or power-law statistical distributions (Pashin, Jin, 

and Payton, 2004) (fig. 44).  

New data collected during this study indicate that the kinematic aperture of fractures in the 

Pottsville Formation can be characterized most simply and consistently using power-law 

functions, and separate functions were derived for joints and shale and sandstone (fig. 44). The 

lower limit of visual observation of kinematic aperture is 0.05 millimeters (mm), thus the dataset 

is truncated below this value. About 35 percent of the joints measured have kinematic aperture at  
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Figure 42.—Histograms showing frequency and mineralogy of cement fills in joints and fault-
related shear fractures in the Black Warrior Basin. 
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Figure 43.—Histograms showing percent of cement coverage in joints and fault-related shear 
fractures of the Black Warrior Basin. 
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Figure 44.—Percentile plots showing exponential distribution of kinematic aperture in mineral-
filled joints hosted by shale and sandstone. 
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or below the lower limit of observation. Fractures with kinematic aperture between 0.07 and 0.80 

mm plot along a nearly straight line in a log-log plot that can be used to define a power-law 

function. Divergence of large-aperture fracture fills from that line reflects undersampling.  The 

results of this analysis indicate that weakly transmissive hairline fractures dominate the joint 

population and that highly transmissive joints with large aperture are relatively rare. Joints in 

sandstone tend to have larger kinematic aperture than those in shale and thus appear to be 

capable of transmitting larger volumes of fluid. 

 

Cleats 

Coal in the Black Warrior Basin is extremely well-cleated (fig. 45), and close spacing of the 

cleats gives the coal the ability to support commercial flow rates. Cleat systems are orthogonal 

networks of vertical fractures that are composed of systematic fractures and cross fractures. In 

coal, face cleats are equivalent to systematic joints, and butt cleats are equivalent to cross joints. 

In the Pottsville Formation, butt cleats almost universally terminate at intersections with face 

cleats. 

As with joints, cleat systems can be subdivided into a regional fracture system and a 

localized system that is restricted to the southeast margin of the Black Warrior basin (Ward and 

others, 1984) (fig. 35B). Face cleats of the regional cleat system strike with a vector mean 

azimuth of N. 62° E., which is 15° east of the regional systematic joints. Face cleats in the 

localized fracture system along the southeast margin of the basin strike with a vector mean 

azimuth of N. 36° W. The orientation of the regional cleat system has been interpreted as the 

product of an Appalachian-wide stress field that formed during Pennsylvanian time (Engelder  
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Figure 45.—Photographs of cleated coal in outcrop showing face cleats and butt cleats. 
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and Whitaker, 2006), whereas the localized cleat systems reflect local stresses associated with 

Appalachian folding (Ward and others, 1984; Pashin and others, 1999). 

Devolatization and shrinkage of matrix during coalification is a source of stress that is 

thought to contribute to the formation of cleats in coal (e.g., Law, 1993; Laubach and others, 

1998). Pashin and others (1999) pointed out that the regional change in orientation between face 

cleats systematic joints reflects different mechanisms of fracturing, different timing of fracturing, 

and rotation of the regional stress field. The cleat direction was probably established during 

major coalification, which occurred during active burial (Telle and Thompson, 1987; Carroll and 

others, 1995), whereas joints probably formed later as stress was released by post-orogenic 

unroofing and cooling.  

Cleat spacing decreases substantially as coal rank increases in the Black Warrior Basin 

(McFall and others, 1986; Pashin and others, 1999) (fig. 46). In high volatile B and lower rank 

coal, for example, primary cleats can be spaced on the order of a decimeter, whereas in low 

volatile bituminous coal, millimeter-scale cleat spacing is common. Whereas joint spacing has a 

log normal distribution, cleat spacing follows a normal distribution (fig. 40). Outcrops and cores 

establish that coal in the Black Warrior Basin is dominated by primary cleats with height 

equivalent to bench or bed thickness. Accordingly, primary cleats define strata-bound fracture 

networks that are even better developed than those in jointed shale and sandstone (fig. 45). 

Secondary cleats, which are contained within benches or beds, form a minor part of the cleat 

population, whereas tertiary cleats, which are restricted to individual vitrain bands, can be 

abundant and are spaced an order of magnitude more closely than primary cleats. 

Measuring cleat aperture in coal can be difficult. Calcite and pyrite cleat fills are common in 

the Black Warrior Basin, but these fills typically display displacive petrographic fabrics  
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Figure 46.—Map showing general relationship between cleat spacing and coal rank in the Black 
Warrior Basin (modified from McFall and others, 1986; Pashin and others, 1999). 

 

indicating that they are not meaningful indicators of kinematic aperture. Coal is an extremely 

stress-sensitive rock type, so aperture measured at surface pressure is not representative of 

aperture at reservoir depth. However, if the statistical distribution of apertures is known, then the 

distribution can be scaled to simulate fracture properties under reservoir conditions. Literature 

provides contrasting information on cleat aperture. Laubach and others (1998) indicated that 

apertures in coal can follow a power-law scaling rule similar to that shown here for joints, 

whereas Mazumder and others (2006) suggested that cleat aperture can be normally distributed 

(fig. 47). 
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Figure 47.—Percentile plot and histogram showing normal distribution of cleat aperture in coal 
(based on data in Mazumder and others, 2006). 

 

Close fracture spacing precludes the incorporation of cleats in large DFN models, thus it can 

be advantageous to model coal in terms of bulk porosity and permeability. If aperture and 

spacing are known, porosity and permeability can be expressed as a function of cleat spacing and 

cleat aperture, such that 
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  = 100 . 2a/s, (1) 

 

where  is porosity, a is aperture, and s is cleat spacing, and 

 

 k = a3/12s, (2) 

 

where k is permeability (Harpalani and Chen, 1995). Well test data indicate that porosity and 

permeability decrease substantially with depth in the Black Warrior Basin (McKee and others, 

1988). Under reservoir conditions, cleat aperture generally ranges from 0.03 to 0.40 mm, and 

porosity is typically less than 0.1 percent (Laubach and others, 1988). Permeability decreases 

exponentially with depth in the Black Warrior Basin such that coal can have permeability on the 

order of 100 to 1,000 mD near the surface and on the order of 1 to 10 mD below a depth of 300 

m (fig. 48). Accordingly, it is common for coalbed methane reservoirs to span more than three 

orders of magnitude of permeability in a single coalbed methane well. 

 

Shear Fractures 

Faults cut across bedding and thus may avenues for leakage of injected CO2. Indeed, Clayton 

and others (1994) investigated a number of exposed normal faults in the Black Warrior Basin 

and found a significant gas seep along one fault in Oak Grove Field. Dipping fractures are a key 

component of fault zones in the Black Warrior basin and consist of crossing synthetic and 

antithetic shears (Pashin and others, 1991; Pashin, 1998) (fig. 33). Synthetic shears dip with the 

associated fault, whereas antithetic shears dip opposite to the fault.  
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Figure 48.—Permeability-depth plot showing exponential decrease of permeability in coal of the 
Black Warrior Basin with increasing lithostatic stress. 

 

An exceptional exposure of a normal fault at the Bankhead Lock and Dam facilitates the 

analysis of shear fractures (fig. 49). The fault strikes N. 28° W. and dips 66° NE. A  thick 

sandstone unit is well exposed in the hanging wall block, and shale is exposed in the footwall 

block. The shale is intensely and chaotically sheared within 2 m of the fault plane and contains 

few fractures farther from the fault. In the sandstone, shear fractures strike nearly parallel to the 

fault plane and have an angular standard deviation of only 13°. Of the 44 fractures measured, 14 

(32 percent) of the fractures are synthetic shears, and 30 (68 percent) are antithetic shears. Dip of 

the shear fractures ranges from 48 to 87°. Dip of the synthetic shears is scattered, whereas dip of 

the antithetic shears is bimodal with peaks at 50° and 78°. Most of the shear fractures cross,  
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Figure 49.—Rose diagram and stereoplot showing orientation of synthetic and antithetic shears 
associated with a normal fault in the Black Warrior Basin. 

 

forming X-type intersections, but where fractures of similar orientation approach, one fracture 

abuts the other, thus forming a J-type intersection. Fracture spacing increases exponentially away 

from the fault for about 22 m, but farther away, shear spacing is fairly uniform (fig. 50). 

Eleven of the cores analyzed intersect normal faults and associated shear fractures. Of 1,897 

fractures analyzed, 80 percent are in shale, and the remainder are in sandstone. Importantly, 

fractures in shale were undersampled because of locally intense shearing and friability. Indeed, 

an important outcome of outcrop and core analysis is that shear fractures have fundamentally 

different distributions in shale and sandstone. In shale, shear-zone deformation predominates in 

which fractures are concentrated in bands narrower than 3 m. In sandstone, by contrast, shear  
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Figure 50.—Plot of fracture spacing versus distance from a normal fault  
in the Black Warrior Basin. 

 

fractures are broadly distributed and have been observed as far as 100 m from fault planes. These 

relationships indicate significant stratigraphic control on shear behavior, with shear-zone 

deformation in mechanically weak shale and distributed deformation in mechanically stiff 

sandstone. Where like rock types are juxtaposed across a fault, fracturing about a fault plane is 

predicted to be relatively symmetrical, but where shale and sandstone are juxtaposed, as at the 

Bankhead Lock and Dam, fracture distribution can be highly asymmetrical. Indeed, examination 

of mine highwalls indicates a significant strata-bound component to shear fracturing (fig. 33).  

Dip of the shear fractures in core is highly variable (fig. 51). In sandstone, mean fracture dip 

is 53°, which is similar to fault dip, and has a normal distribution. In shale, however, mean dip is 

substantially lower at 38°, and the distribution of dip is positively skewed. The weak central  
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Figure 51.—Histograms showing dip of fault-related shear fractures measured in cores  
from the Black Warrior Basin. 
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tendency of dip values in shale relative to sandstone reflects the chaotic nature of shear-zone 

deformation in shale. 

Mineral cement was observed in only 12 percent of the shears studied in core (fig. 42B). As 

in joints, calcite is the dominant fracture-filling cement in fault-related shear fractures. Calcite 

was identified in 84 percent of the mineralized fractures, and pyrite, clay, and quartz are 

accessory fracture-filling minerals. Cement covers more than 80 percent of fracture surfaces in a 

minority of the mineralized shears (fig. 43B). About 60 percent of the mineralized fractures have 

cement coverage between 1 and 80 percent, indicating that significant porosity exists along 

mineralized shear fractures. As in joint networks, cement has a patchy distribution in fault-

related shear fractures. If the nonmineralized shears are open, they can support flow and should 

be considered carefully when developing carbon sequestration and enhanced coalbed methane 

recovery programs. 

Like joints, nearly all shear fills are simple and can be used to determine kinematic aperture, 

and percentile plots of kinematic aperture can be characterized using power-law statistical 

distributions (fig. 52). More than 50 percent of the shears measured in shale have a kinematic 

aperture equal to or less than 0.05 mm, whereas only about 30 percent of the shears measured in 

sandstone fall in this range. As in joint networks, weakly transmissive hairline fractures 

dominate the shear population, and highly transmissive shears with large aperture are relatively 

rare. Shears in sandstone tend to have larger kinematic aperture than those in shale and thus 

appear capable of transmitting larger volumes of fluid.  
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Figure 52.—Percentile plots showing exponential distribution of kinematic aperture in mineral-
filled, fault-related shear fractures hosted by shale and sandstone. 
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Simulation Based on SECARB Test Site 

Background 

The SECARB Black Warrior field test will center on injection of about 907 tonnes (1,000 

short tons) of CO2 into a mature production well in Deerlick Creek Coal Degasification Field 

(fig. 1), where technical feasibility and the potential for commercial application of carbon 

sequestration technology are considered to be high (Pashin, Carroll, and others, 2004). Coalbed 

methane in the test area is produced from multiple seams with diverse reservoir properties that 

are distributed through a thick stratigraphic section (fig. 53). Multiple seam completion 

technology was developed to recover gas from coal seams with a broad range of reservoir 

properties (Graves and others, 1983; Schraufnagel and others, 1991; Young and others, 1993), 

and injection procedures will need to be optimized to realize the sequestration and CO2-enhanced 

recovery potential offered by multiple coal seams. Additionally, procedures need to be developed 

and optimized that will provide for safe and permanent storage of CO2 in coal seams. 

Accordingly, the SECARB Black Warrior field verification test is the first step in this 

optimization process. 

As is typical of wells in Deerlick Creek Field, the J. D. Jobson 24-14 #11 well is completed 

in the Black Creek, Mary Lee, and Pratt coal zones (fig. 53). The well has a total depth of 792 m 

(2,460 feet). Beds in the Pratt and Mary Lee coal groups were perforated through casing adjacent 

to coal beds. A coal bed at the top of the Black Creek group was similarly perforated, and the 

prominent Black Creek bed was completed in open hole between 2,470 and 2,488 feet. A sand 

plug was placed in the well from 2,488 feet to total depth prior to hydrofracturing. Completion 

records indicate that the well was hydrofractured in multiple stages to ensure each coal zone 

could be effectively isolated and stimulated. The Jobson well is historically an above average  
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Figure 53.— Geophysical well log of the J. D. Jobson 24-14 #11 well (State Oil and Gas Board 
of Alabama permit 4001-C) showing perforated coal beds and injection zones to be used in the 

SECARB Black Warrior field verification test. 
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producer of both gas and water, but production has declined to the point where the well can be 

considered as a candidate for plugging and abandonment (fig. 54). 

Southern Deerlick Creek Field has been an area of intensive geological investigation (e.g., 

Wang and others, 1993; Pashin and others, 1995; Pashin and Groshong, 1998; Groshong and 

others, 2003). Pottsville strata in this area are nearly flat-lying and are cut by normal faults 

defining a horst-and-graben system (fig. 55). The test site sits in a structural low in the hanging-

wall block of a normal fault having about 45 m of vertical displacement. A three-dimensional 

structural model indicates that the fault dips southwest toward the Jobson well but does not 

intersect the well (fig. 56). Wells intersecting the fault within the Black Creek-Pratt production 

interval have produced only minor quantities of water and gas, which suggests that the fault 

forms an effective seal (Groshong and others, 2003; Pashin, Jin, and Payton, 2004). Based on the 

volumetric analysis of Pashin, Carroll, and others (2004), coal in the area of the test site has the 

capacity to sequester about 1,580 tonnes (1,740 short tons) of CO2 per acre at a modest pressure 

of 2.41 MPa (350 psi). Therefore, the field verification test is expected to affect only the area 

immediately surrounding the injection well. 

Detailed synopses of injection and monitoring activities are available in Pashin and Clark 

(2006), Pashin and others (2007), and McIntyre and others (2008), and a brief summary is given 

here. Testing in the Jobson well will comprise a series of production-buildup and injection-falloff 

tests (fig. 57). All injection is to be conducted below the critical point for CO2 (31°C, 7.4 MPa). 

First, a production-buildup test (T1) will be used to determine the time it takes for pressure to 

stabilize in the well and to determine the stabilized shut-in pressure. Next, injection-falloff tests 

will be performed using CO2. An initial slug of 40 short tons of CO2 (T2) will be injected into the 

Black Creek coal to determine baseline injectivity and to help estimate the pressure and rate at  
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Figure 54.—Production curves showing long-term decline of gas and water production from the 
J. D. Jobson 24-14 #11 well in southern Deerlick Creek Field. 

 

which a larger quantity of CO2 can be injected. After pressure stabilizes, a larger slug of up to 

280 short tons of CO2 (T3) will be injected to determine longer term changes of injectivity and 

pressure response. After pressure stabilizes in the Black Creek coal, these tests will be repeated 

at higher stratigraphic levels (T4-T7). After the injection-falloff tests are completed, another 

production-buildup test will be performed to determine if reservoir properties have changed (T8). 

 The monitoring program has been designed to ensure the safety and effectiveness of the field 

verification test and includes several subsurface and surface techniques. Deep subsurface 

monitoring will be conducted using the three observation wells that will be drilled through the 

Black Creek coal (figs. 58, 59). Inflatable packers will be installed to isolate the target coal beds, 

and pressure transducers and fluid samplers will be placed in the wells. Pressure data will  
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Figure 55.—Structural contour map of the top of the Gwin coal zone in southeastern Deerlick 
Creek Field showing location of the SECARB Black Warrior test site in the Franklin Hill half 

graben (modified from Pashin and Groshong, 1998) 
 

provide a basis for analysis of interference, permeability anisotropy, and the effect of 

hydrofractures.  Simultaneous monitoring in multiple coal groups will be useful for determining 

if significant cross-communication exists between the coal zones and will be useful for verifying 

the DFN models, flow models, and risk assessment offered herein. To further ensure that field 

operations are safe and effective, water quality will be monitored in a shallow well, and the 

composition and flux of soil gas are being monitored (McIntyre and others, 2008). 
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Figure 56.—Three-dimensional structural model showing relationship of the J. D. Jobson 24-14 
#11 well and the SECARB field verification test site to a normal fault separating the Franklin 
Hill half graben from the Sexton Spring Horst (modified from Groshong and others, 2003). 

 

 

 

Figure 57.—Sequence of production-buildup and injection-falloff tests to be performed in the  
J. D. Jobson 24-14 #11 well. 

 



 81

 

Figure 58.—Diagrammatic layout of observation wells and surface monitoring stations at the 
SECARB Black Warrior field verification test site. 

 

DFN Models 

Fracture networks in the upper Pottsville Formation have statistical properties that are readily 

quantified and are therefore suited for the development of DFN models. This section reviews 

selected DFN models that were developed during this project, which include models of joint 

systems, cleat systems, fault-related shear fractures, and induced hydraulic fractures. Results 

presented here also include a discussion of compartmentalization and pathways analysis in 

selected DFN models. As mentioned previously, these models are offered not only as tools to 

evaluate the carbon sequestration and enhanced coalbed methane recovery potential of the Black  
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Figure 59.—Generalized diagram showing injection and multi-zone subsurface monitoring 
scheme to be employed at the SECARB Black Warrior test site. 

 

Warrior Basin, but to provide users with ideas that can be used to apply DFN models to other 

prospective geologic carbon sinks that contain natural fractures. 

The first step in modeling the SECARB test site was to develop a DFN model based on the 

stratigraphic section recorded in the geophysical log of the Jobson 24-14 #11 well (fig. 53). 

Accordingly, a DFN model was constructed that simulates fracturing in 96 layers of shale, 

sandstone, and coal in an area of four square kilometers (fig. 60). To give a feel for scale relative 

to well spacing in the Black Warrior Basin, the DFN model was constructed with four vertical 

wells spaced at 40 acres. The model was constructed on a bed-by-bed basis according to the  
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Figure 60.—Jointed DFN model based on stratigraphic relationships in the Jobson 24-14 #11 
well and observations of fractures in core and outcrop. 

 

statistical properties of Pottsville fracture networks described above earlier in this report. For 

each shale and sandstone bed, networks of joints and cross joints were simulated. For example, a 

DFN model of a joint network in a sandstone bed is color-contoured by fracture aperture (fig. 

61). This model honors the power-law distribution of fracture aperture, which indicates that joint 

networks are dominated by poorly transmissive hairline fractures and that highly transmissive 

fractures with aperture greater than 1 mm are few. The complete DFN model contains 16 coal 

beds, which were modeled as horizontal porous strata parameterized with permeability,  
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Figure 61.—DFN model of a joint network in a sandstone bed. Note that joint network is 
dominated by hairline fractures. 

 

transmissivity, and storativity values based on the well-test data of McKee and others (1988) 

(fig. 62).  

To better understand the impact of cleating on reservoir heterogeneity in coal, data on cleat 

spacing and aperture (figs. 40B, 47) were used to construct a simple DFN model (fig. 63). The 

cubic law function of Harpalani and Chen (1995) was used to scale the cleat apertures to 

simulate coal with bulk permeability of 100 mD, 10 mD, and 1 mD, which is representative of 

the range of permeability observed in most coalbed methane wells in the Black Warrior Basin. 

Color contouring the DFN models by storage and transmissivity reveals significant contrast  
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Figure 62.—Storativity model of coal beds in the Jobson 24-14 #11 well. 
 

between shallow, permeable and deep, tight coal seams (fig. 64). The storativity model shows a 

loss of storage capacity that corresponds to the decrease of fracture aperture with decreasing 

permeability. Transmissivity is a function of permeability and layer thickness and so shows the 

effect of cubic law on reservoir properties. What is especially notable is the extreme 

transmissivity contrast at 100 mD and the general lack of contrast at 10 mD or less. This result is 

consistent with interference test results from the Black Warrior Basin that show extreme 

permeability anisotropy favoring flow the face cleat direction in the shallow, highly permeable  
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Figure 63.—DFN model of cleat systems with fractures color contoured by aperture. Vertical 
exaggeration = 5x. 

 

coal of the Pratt zone and limited or negligible anisotropy in deep, less permeable coal of the 

Mary Lee and Black Creek zones (Koenig, 1989). 

DFNModeler is also capable of modeling hydraulic fractures (fig. 65). The example shown 

here is based on models of hydrofractures that operators submit to the State Oil and Gas Board as 

part of their hydraulic fracturing programs (summarized in Pashin, Jin and Payton, 2004). The 

DFN models incorporate the hydraulic fractures as elliptical structures that extend laterally for an 

average of 93 m and vertically for an average of 24 m. Induced fractures tend to propagate 

parallel to the maximum horizontal compressive stress, which in the Black Warrior Basin is 

directed at about N. 75° E. (Zoback and Zoback, 1989; Steidl, 1993). Hydrofractures are propped  
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Figure 64.—DFN models of cleat systems with fractures color contoured by  
storativity and transmissivity. Vertical exaggeration = 5x. 

 

that some hydraulic fractures are solitary structures, although hydrofractures within the same 

coal zone can grow into each other. 

Simulation of faults and fault-related shear fractures in the Black Warrior Basin proved 

challenging. The original faulted DFN models of Pashin, Jin, and Payton (2004) modeled normal 

faults with a symmetrical swarm of shear fractures developed around a fault plane. However, 

analysis of cores and outcrops indicates that shale and sandstone beds fracture in fundamentally 

different ways and that networks of fault-related shear fractures contain distinctive strata-bound 

elements (figs. 33). In shale, fault-related are concentrated within 10 m of the fault plane and 

form shear zones in which the orientation of individual fractures is highly variable. In sandstone, 

by comparison, shear fractures are organized into a well-defined network of synthetic and  
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Figure 65.—DFN model of coal seams and hydraulic fractures in the Jobson 24-14 #11 well.  
No vertical exaggeration 

 

by 20 to 40 mesh sand and thus have aperture between 0.4 and 0.8 mm. The DFN model shows 

antithetic shears and are distributed in a wide zone that can extend up to 100 m from the fault 

plane (fig. 50). These differences result in an extremely complex fracture architecture that is 

controlled by the juxtaposition of different rock types at the fault plane (fig. 66). Where like rock 

types are juxtaposed, fracturing around the fault plane is fairly symmetrical. Where different 

rock types are juxtaposed, fracturing about the fault plane is highly asymmetrical. 

Compartmentalization analysis was performed on the major DFN model based on the Jobson 

24-14 #11 well (fig. 53) and indicates that strata-bound fracturing in the Pottsville Formation 

facilitates compartmentalization of the hydrologic system (fig. 67). Closely spaced coal beds that 

are interconnected by joints and hydraulic fractures fall within the same hydrologic 

compartments. Accordingly, the Mary Lee and Black Creek coal zones constitute a deep 

reservoir compartment, the Pratt coal zone constitutes an intermediate reservoir compartment, 

and the Gwin and Utley coal zones constitute a shallow compartment. Interestingly, Pashin, Jin  
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Figure 66.—DFN model of coal seams, a normal fault, and fault-related shear fractures.  
No vertical exaggeration. 

 

and Payton (2004) reported nearly identical results when performing compartmentalization 

analysis on a similar DFN model based on a different well. These three major compartments are 

separated by thick intervals of interbedded shale and sandstone, which contain numerous second-

order compartments. These second-order compartments represent stranded clusters of 

interconnected joints that are not in hydraulic communication with the coalbed methane 

reservoirs. Stacking of numerous shale and sandstone units with separate strata-bound joint 

networks is the principal mechanism of compartmentalization. Pathways analysis based on the 

four wells in the DFN model simply highlights the first-order compartments, which contain coal 

seams that extend across the model. 

Compartmentalization analysis of faulted DFN models indicates that fault zones can form 

significant conduits for cross-formational flow. DFN models containing only coal seams and  
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Figure 67.—Results of compartmentalization analysis. Note that shallow coal zones are in a 
compartment that is separate from the reservoir coal zones and that small, stranded joint 

compartments are stranded between the major reservoir compartments. 
 

fault-related fractures maintain a high degree of compartmentalization that is similar to that 

observed in the jointed DFN models (fig. 68). In the faulted models, shale-shale juxtapositions 

within the thick mud-rich intervals separating the major coal zones act as bottlenecks that help 

compartmentalize the system. Complete models incorporating joints, however, do not contain 

major compartments separating the major coal zones (fig. 69). Instead, a first-order compartment 

envelops the entire DFN model, and contains numerous second-order compartments containing 

stranded joint networks. The results of compartmentalization analysis indicate that 

communication among joints and fault-related shear fractures can facilitate cross-formational  
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Figure 68.—Compartmentalization analysis of a DFN model containing coal-seams and fault-
related shear fractures. Note the development of first-order compartment hulls enveloping coal 

zones and second-order compartment hulls that are elongated along strike of the fault. 
 

flow. The requirement for communication among joints and shears to break down the major 

reservoir compartments further indicates that significant cross-formational flow should occur 

only in close proximity to fault zones. 

 

FLOW MODELING 

Having developed and analyzed DFN models of fracture networks of Pottsville, flow models 

can then be constructed. Flow modeling software packages, such as TOUGH2, are too 

computationally intensive to model flow within extremely large DFN models with tens of 

thousands of fractures. However, flow models can be constructed using subsets of the large DFN 

models to test hypotheses and identify critical controls on subsurface flow in fractured media. 

Discussion of these flow models begins with a review of key model parameters, continues by  
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Figure 69.—Compartmentalization analysis of a faulted DFN model that includes joint networks. 

Note that a first-order compartment hull envelops the complete DFN model and contains 
numerous second-order hulls. 

 
 
considering the impact of fractures on the flow of injected CO2, and concludes by modeling the 

impact of strata-bound fracture networks on fluid flow. 

 

Model Parameters 

Sandstone and shale in the coalbed methane fields have extremely low matrix permeability. 

For example, upper Pottsville sandstone is litharenite with permeability below 0.06 mD (Pashin 

and Hinkle, 1997), and conventional core analyses indicate that permeability is below the limits 

of detection of standard permeameters. In the flow models, the permeability of shale and 
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sandstone was modeled as being on the order of a microdarcy, or 1 x 10-18 m2. Porosity values for 

shale and sandstone were assigned as 2 percent and 15 percent, respectively. 

The average permeability of coal was modeled as decreasing with depth following the well-

test results of McKee and others (1988).  The permeability of the shallowest coal zone (Utley) is 

estimated to be 233mD (2.3 x 10-13 m2), whereas that of the deepest zone (Black Creek) is 

estimated to be about 1 mD (9.87 x 10-16 m2). Permeability can vary more than one order of 

magnitude at any given depth, and so well-test data are desirable for constraining permeability in 

coalbed methane reservoirs.  Though coal is typically considered as a dual continuum consisting 

of coal matrix and cleats, it is modeled as single continuum that averages matrix and cleat 

properties here. Permeability anisotropy due to the coal cleat systems was incorporated into the 

models. The porosity of coal decreases with depth and has been modeled as ranging from 5 

percent at the surface to less than 1 percent at reservoir depth (Pashin, Jin, and Payton, 2004). 

Capillary pressure and liquid relative permeability values were selected using van Genuchten 

functions (van Genuchten, 1980). The Corey function (Corey, 1954) was used to calculate the 

relative permeability of CO2. The parameters for Genuchten functions and Corey function used 

in this study follow examples given in the ECO2N manual (Pruess, 2005). Injection pressures 

and rates were modeled using a variety of values based on known reservoir pressures and likely 

injection pressures to be used during sequestration and enhanced recovery operations. 

 

Effect of Fractures and Rock Matrix 

Several 3-D, two-phase CO2 injection models were constructed to simulate the effect of 

discrete fractures. In all runs, model length and width were 1 km, and model height was 45 m. 

Each model consists of five layers of shale, sandstone, and coal. Vertical grid size is a maximum 
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of 10 m, depending on bed thickness, and horizontal grid blocks were 10 x 10 m. A sandstone 

bed above coal was modeled as containing four discrete fractures with the same aperture (fig. 

70). The fractures are arranged in a rectilinear pattern with the center of each fracture located 50 

m from a well (fig. 70B). 

Injection of CO2 is modeled as taking place in the center of the coal layer (fig. 70B). 

Injection rate was modeled at 0.05 kilograms per second (kg/s), or 4.32 tonnes per day, which is 

consistent with the injection rate planned for the SECARB Black Warrior field test. In this 

model, rock matrix was discretized into 16,425 grid blocks. Boundary conditions for the model 

include zero CO2 saturation prior to injection, hydrostatic reservoir conditions, and a reservoir 

temperature of 25°C.  

Seven simulations were performed using different fracture apertures to determine the effect 

of fracture aperture on the leakage of injected CO2 from coal into fractures in the overlying 

sandstone (fig. 71). Fracture apertures used for the models range from 0.001 mm to 1 mm. 

Simulating 4,000 days, or more than a decade, of continuous injection indicates that fracture 

aperture has a major influence on leakage of injected CO2 from coal into adjacent strata. Leakage 

is negligible through hairline fractures having aperture of 0.05 mm or smaller (fig. 71, table 1).  

By comparison, large aperture fractures with aperture greater than 0.1 mm pose significant 

leakage risks (fig. 71, table 1). Moreover, fractures with aperture on the order of 1 mm can form 

major leakage pathways, and the pattern of four fractures modeled in this study can capture 20 to 

40 percent of the injected CO2 during continuous injection operations lasting longer than 1,000 

days. For short-term experiments lasting less than 30 days, like the SECARB Black Warrior field 

test, however, these leakage risks are limited by the small volume of CO2 that will be used.  
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Figure 70.—Locations of fractures and injection well in flow models testing influence of 
individual fractures on leakage of injected CO2. A) Overview of model. B) Plan view. 
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Figure 71.—Flow modeling results showing the effect of fracture patterns with different aperture 
on leakage of injected CO2 from coal into joints in sandstone. 

 

 

Table 1. Calculated leakage for different fracture apertures of injected CO2 based on flow 
modeling of a pattern of four rectilinear fractures located 50 m from an injection well. 

 
Aperture (mm) Leakage (%) 

1.0 23.70 
0.5 13.55 
0.1 3.05 
0.05 1.55 
0.01 0.29 

0.005 0.12 
0.001 0.003 

 



 97

Three additional flow models were made using a fracture aperture of 0.5 mm to investigate 

the effect of microdarcy-class matrix permeability on leakage of injected CO2 through fractures. 

In these models, sandstone permeability was investigated at 5 x 10-18 m2 (high), 1 x 10-18 m2 

(middle) and 5 x 10-19m2 (low) (fig. 72). Results indicate that increased matrix permeability, even 

at the microdarcy level, can help reduce leakage of injectate through fractures during multi-year 

injection operations. Accordingly, permeable streaks in sandstone beds appear to be 

advantageous during sequestration operations provided that bounding shale units have sufficient 

sealing capacity. 

 

Effects of Strata-Bound Fracture Networks 

Whereas the preceding discussion considers the leakage of injected CO2 from coal, this 

section considers the effect of strata-bound fracture networks on trans-stratal flow and leakage. 

To characterize the impact of strata-bound fracture networks, three realizations of a DFN model 

containing four stratigraphic units were constructed in DFNModeler. The area of the model is 

500 m2, and the height of the model is 19.5 m, and the model simulates two coal beds, a bed of 

shale, and a bed of sandstone (fig. 73). 

One challenge for modeling fluid flow in fractured media is incorporating discrete fractures. 

Although TOUGH2 provides a way to grid unstructured features for flow model, there is no 

procedure on directly gridding the discrete fracture networks. As part of this study, a procedure 

was developed to characterize the connectivity of fractures within layers and among layers and to 

generate grid blocks four TOUGH2 that accurately represent fracture location and connectivity 

in the original DFN model. Because joints and cleats are effectively vertical, 3-D DFN 

realizations of individual beds can be projected into two dimensions without losing significant  
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Figure 72.—Flow modeling results showing the effect of microdarcy-class matrix permeability 
in sandstone on the leakage of injected CO2 through fractures. 

 

information (fig. 74). Interconnectivity of the fractures can further be characterized using a 

hierarchical box diagram (fig. 75). Based on the distribution of fractures in each bed, fracture 

grid blocks are defined and superimposed on a grid of rock matrix properties. 

In all realizations based on the DFN models, CO2 is modeled to be injected in the center of 

the lower coal layer. The injection rate was modeled at 0.01 kg/s (0.86 tonnes per day). Parallel 

to bedding, the matrix grid blocks represent an area of 10 m2. The number of grid fracture grid  
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Figure 73.—Simple diagram showing stratigraphic framework consisting of coal (black), shale, 
and sandstone that was used to model flow in strata-bound fracture networks. 

 

blocks used in each realization is variable and depends on the number of intersections that exist 

between the matrix grid and the fracture grid. In the first realization run, for example, 1,780 

fracture grid blocks are required to accurately simulate the DFN model. Boundary conditions for 

the flow models are the same as those discussed earlier for the models of leakage into fractures 

and matrix. 

An important result of flow modeling is that the strata-bound nature of the fracture system 

causes major dissipation of flow from a coal bed into successive overlying beds (fig. 76). 

Hydraulic communication between strata-bound joint systems is restricted to narrow pore throats 

where joints of differing orientation intersect at bed boundaries. Because only small segments of 

joints can communicate across major bedding contacts, the dissipation of flow into successive 

beds is substantial. Moreover, the odds of linkage between two large-aperture fractures in 

successive beds appears to be remote. In the model shown here, the rate of leakage decreases by 

about an order of magnitude from bed to bed. The other realizations modeled in this investigation  
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(A) Sandstone (B) Shale 

     
 

(C) Both layers 

 
 

Figure 74.—Two-dimensional plan-view representations of DFN models of joint networks in 
two successive beds of (A) sandstone and (B) shale and (C) a composite of the two models. 

 

show similar results, although the magnitude of leakage is influenced significantly by differences 

in fracture architecture.  

RISK ASSESSMENT 

DFN models have been used to assess risks associated with hydrofracturing and other 

coalbed methane  operations in the Black Warrior Basin (Pashin, Jin and Payton, 2004), and 

DFN models can similarly be used to assess risks associated with carbon sequestration and 

enhanced coalbed methane recovery. This section considers the utility of DFN models and DFN- 
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Figure 75.—Diagram showing linkages among fractures in the sandstone and shale bed  

shown in Figure 74. 
 

 

 

Figure 76.—Plot showing modeled magnitude of leakage of injected carbon dioxide from coal 
into overlying strata containing strata-bound joint networks. 
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based flow models for assessing risks associated with sequestration in coal-bearing strata. 

Critical points that are emphasized throughout the discussion are the applicability of these 

models to the Black Warrior Basin and the advantages and shortcomings of these models as risk 

assessment tools. 

DFN models are powerful tools for the simulation and analysis of fracture networks (figs. 60-

69). However, the stochastic nature DFN models dictates that they cannot be used to precisely 

reproduce reservoir conditions in a specific field area because high-transmissivity fractures are 

likely to be realized where they do not exist in nature. For this reason, DFN models cannot be 

used reliably for the development of history matched reservoir models. Rather, the role of these 

models is to help develop and test hypotheses by simulating the fundamental geometric and 

statistical properties of fracture networks. Using this type of approach, modelers can inform the 

risk assessment process by characterizing the way these basic relationships affect the behavior of 

aquifers, hydrocarbon reservoirs, and geologic carbon sinks.  

Pottsville coalbed methane reservoirs have been interpreted on the basis of reservoir pressure 

and water chemistry as part of a highly compartmentalized reservoir system that favors bed-

parallel flow in coal (e.g., Pashin and McIntyre, 2003; Pashin, 2007). The results of DFN 

modeling and compartmentalization analysis corroborate this finding and indicates that the 

predominance of strata-bound joint networks limits the probability of surface seepage (figs. 60, 

67). However, these models indicate that substantial communication may occur among closely 

spaced coal seams through large-aperture fractures and hydrofractures.  

Although communication among coal seams does not appear to pose a safety hazard, it is a 

source of operational risk that may reduce the efficiency of sequestration and enhanced gas 

recovery efforts. Simulation of the SECARB Black Warrior test site, for example, indicates that 
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some hydraulic communication through natural fractures and hydrofractures may exist between 

the Black Creek and Mary Lee coal zones during injection, but no significant communication 

should take place between the Pratt coal zone and the other coal zones (fig. 67). Formation of 

first-order reservoir compartments around the major reservoir coal zones reflects the 

predominance of bed-parallel flow with coal seams and predicts that shallow aquifers should be 

protected from injection operations in the Black Creek through Pratt coal zones. 

Trans-stratal joints exist in the Pottsville Formation but are not abundant enough to 

characterize statistically and therefore were not included in the DFN models. Indeed, one 

shortcoming of DFN models is that they rely on the identification of geometric and statistical 

relationships that can be quantified, so any factors that exist in the reservoir that are beyond the 

realm of observation and quantification can potentially invalidate a model. The principal risk 

posed by trans-stratal fractures is that, where they occur, little is known of their vertical extent or 

their relationship to the strata-bound networks that dominate the Pottsville Formation. For this 

reason, careful well testing and monitoring is important, not only to corroborate the models 

offered here, but  to ensure the safety of sequestration operations in the field.  

Faults provide the most obvious trans-stratal discontinuities in the Pottsville Formation (figs. 

33, 66) and thus appear to be a significant source of risk. DFN models indicate that interaction 

among fault-related shear fractures and joints breaks down the first-order reservoir compartments 

enveloping the major coal zones and thus poses the greatest risk for leakage in fault zones (figs. 

68, 69). Examination of production data, however, shows that the performance of coalbed 

methane reservoirs is affected strongly by the hydrogeologic setting of fault systems (Groshong 

and others, 2003; McIntyre and others, 2003; Pashin, Jin, and Payton, 2004). Near a major 

recharge zone along the southeastern margin of the Black Warrior Basin, wells penetrating 
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normal faults can produce anomalously high volumes of water, which indicates that faulting may 

have enhanced permeability. Distal to recharge in the interior of the basin, coal seams adjacent to 

faults tend to be cemented with calcite and are associated with exceptionally low gas and water 

production.  

Variable well performance in fault zones indicates that faults should be considered seriously 

when designing sequestration and enhanced coalbed methane recovery programs. From a 

practical standpoint, faults are fundamental discontinuities that limit the amount of reservoir that 

can be contacted by an injection well. In addition, formation of carbonic acid during injection of 

CO2 can dissolve calcite cement and thus degrade the integrity of fault seals. Therefore, risk can 

be minimized and efficiency can be optimized if injection wells are kept away from faults. When 

designing five-spot programs, locating production wells between injectors and faults will limit 

risk by creating pressure sinks that  ensure that CO2 flows away from fault zones. 

DFNModeler is capable of constructing extremely complex DFN models simulating tens of 

thousands of fractures (figs. 61-66), but these models are far too large for flow modeling using 

computational intensive software packages like TOUGH2. Because of this, flow models need to 

be constructed for subsets of larger DFN models and must be designed to test specific aspects of 

fracture architecture. In general, DFN-based flow models are subject to the same limitations as 

DFN models and are best used as tools to test fundamental geologic relationships and to aid in 

the testing and formulation of hypotheses related to risk. Testing multiple realizations of DFN 

models, moreover, helps add depth to this type of assessment because multiple realizations help 

constrain the variability that is inherent in naturally fractured reservoir systems. 

Results of modeling in the Black Warrior Basin indicate that fracture aperture and 

connectivity are critical parameters affecting the leakage of injected CO2 from coal (figs. 71, 74, 
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76). The vast majority of joints and fault-related shear fractures are hairline fractures with 

negligible transmissivity. However, fractures with aperture larger than 0.1 mm can capture a 

significant amount of injected CO2, and highly transmissive fractures with aperture on the order 

of 1 mm have potential to divert a large percentage of an injected CO2 stream away from a target 

coal seam (fig. 71). Hence, the location of transmissive fractures relative to a wellbore may have 

a strong impact on the performance, efficiency, and predictability of sequestration and enhanced 

coalbed methane recovery operations. This risk appears to be greatest within coal zones where 

seams are closely spaced and are separated by few beds of shale and sandstone. 

Although highly transmissive fractures may divert a significant amount of CO2 from a target 

coal seam, the strata-bound nature of Pottsville fracture systems is a natural factor that mitigates 

the risk of long-range leakage and surface seepage. The probability that highly transmissive 

fractures are connected in successive beds is low, and communication between strata-bound 

joints can occur only through narrow throats at bedding contacts where fractures of different 

orientation overlap (fig. 74). The result of this configuration is that cross-formational flow is 

dissipated by about an order of magnitude from bed to bed (fig. 76). In this respect, strata-bound 

joint networks are self-compartmentalizing, and the thick successions of interbedded shale and 

sandstone that separate the Pottsville coal zones are interpreted as confining units that protect 

shallow coal zones from injection operations in reservoir coal zones.  

 

SUMMARY AND CONCLUSIONS 

Coal is potentially an important sink for the sequestration of carbon dioxide, and a software 

package called DFNModeler has been developed to assess the potential risks associated with 

carbon sequestration in coal. Natural fractures provide the principal conduits for fluid flow in 



 106

coal-bearing strata, and these fractures present the most tangible risks for the leakage of injected 

carbon dioxide. DFN models are stochastic realizations based on the statistical properties of 

fracture networks. These models have been used successfully to assess leakage risks associated 

with hydraulic fracturing and coalbed methane production, and these models show promise for 

assessing risks associated with carbon sequestration in coal. The objectives of this study were to 

develop DFN modeling tools for risk assessment and to use these tools to assess risks in the 

Black Warrior Basin of Alabama, where coal-bearing strata of the Pennsylvanian-age Pottsville 

Formation have high potential for carbon sequestration and enhanced coalbed methane recovery. 

DFNModeler software runs under Microsoft Windows operating systems and provides an 

interactive, user-friendly environment for the construction, visualization, and analysis of DFN 

models. The software is driven by a system of menus and dialog boxes that facilitates the input 

and editing of the parameters required to construct DFN models and enables users to customize 

the appearance of those models. DFNModeler employs an OpenGL graphics engine that enables 

real-time translation, zooming, and rotation of DFN models and further gives users control over 

scale, color, and transparency. Analytical capabilities in DFNModeler include color contouring 

of fracture polygons according to structural and hydrologic parameters, compartmentalization 

analysis, and fluid pathways analysis. DFN models can be exported as text files to third-party 

software packages, such as TOUGH2, for flow modeling. 

DFN models were constructed to simulate fracturing in coal-bearing strata of the upper 

Pottsville Formation in the Black Warrior Basin. Geophysical well logs from the Jobson 24-14 

#11 well, which is being used for the SECARB Black Warrior field test for carbon sequestration 

and enhanced coalbed methane recovery in Deerlick Creek Field, were used as the primary 

stratigraphic control for the models. Outcrops and wireline cores were used to determine the 
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basic statistical scaling rules for fracture systems in the upper Pottsville, which include 

orthogonal joint systems, cleat systems, and fault-related shear fractures. Critical variables 

analyzed include the orientation, length, height, spacing, kinematic aperture, and cross-cutting 

relationships for each type of fracture. Results of fracture analysis indicate that the Pottsville 

Formation is dominated by strata-bound fracture networks. Fracture aperture tends to follow 

power-law distributions dominated by hairline fractures with kinematic aperture smaller than 

0.05 mm. Highly transmissive fractures with aperture on the order of 1 mm, by contrast, form a 

small percentage of the fracture population. 

A large DFN model simulating jointing in 96 beds of shale, sandstone, and coal was 

constructed. DFN models were also constructed to simulate cleating, faulting, and hydraulic 

fracturing. Analysis of transmissivity in cleats systems indicates that a strong permeability 

anisotropy is developed in shallow, permeable coal seams and that a loss of transmissivity 

contrast in deep, low-permeability seams makes anisotropy negligible. Compartmentalization 

analysis indicates that strata-bound fracturing compartmentalizes the Pottsville hydrologic 

system. First-order reservoir compartments envelop the major coal zones, and these 

compartments are separated by thick successions of interbedded shale and sandstone that help 

protect shallow coal seams that may be useful aquifers from operations at reservoir depth. 

Compartmentalization analysis of faulted DFN models, however, suggests that communication 

among joints and fault-related shear fractures can facilitate cross-formational flow, and so fault 

zones should be avoided when siting injection wells. Aligning production wells near faults, 

moreover, can help limit risk by forming pressure sinks between injectors and fault zones. 

Flow models were constructed in TOUGH2 software to determine the impact of individual 

fractures and strata-bound fracture networks on the leakage of injected CO2 from coal seams. 
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Results of flow modeling in the Black Warrior Basin indicate that fracture aperture and 

connectivity are critical parameters affecting the leakage of injected CO2 from coal. Highly 

transmissive fractures near an injection well have potential to divert a large percentage of an 

injected CO2 stream away from a target coal seam. Therefore, highly transmissive fractures may 

impact the performance, efficiency, and predictability of sequestration and enhanced coalbed 

methane recovery operations. However, the strata-bound nature of Pottsville fracture systems is a 

natural factor that mitigates the risk of long-range leakage and surface seepage. DFN models 

indicate that the probability of direct communication between highly transmissive fractures in 

successive beds is low. Flow models indicate that cross-formational flow in strata-bound joint 

networks is low and is dissipated by about an order of magnitude at each successive bedding 

contact. These models help confirm that strata-bound joint networks are self-compartmentalizing 

and that the thick successions of interbedded shale and sandstone separating the Pottsville coal 

zones are confining units that protect shallow aquifers from injection operations at reservoir 

depth. 

DFN models are powerful tools for the simulation and analysis of fracture networks and can 

play an important role in the assessment of risks associated with carbon sequestration and 

enhanced coalbed methane recovery. Importantly, the stochastic nature DFN models dictates that 

they cannot be used to precisely reproduce reservoir conditions in a specific field area. Rather, 

these models are most useful for simulating the fundamental geometric and statistical properties 

of fracture networks. Because the specifics of fracture architecture in a given  area can be highly 

uncertain, multiple realizations of DFN models and DFN-based flow models can help define 

variability that may be encountered during field operations. Using this type of approach, 
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modelers can inform the risk assessment process by characterizing the types and variability of 

fracture architecture that may exist in geologic carbon sinks containing natural fractures.  
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